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ABSTRACT 

Three-dimensional (3D) cell spheroid model has been long considered a better 

model to mimic in vivo physiology compared to two-dimensional (2D) cell culture 

model. Traditional 2D cell models provide a simple, convenient and quick technique for 

drug screening but fail to simulate the complexity and heterogeneity of cells in the in vivo 

environment. The last few decades have remarked substantial progress toward the 

advancement of three-dimensional (3D) cell cultures as systems which better mimic cell-

cell and cell-matrix interaction in the in vivo physiology. Nowadays, 3D cell models have 

been emerging, not only as an important approach in drug discovery and tissue 

engineering but also as potential therapeutics assessment for the development of new 

anticancer strategies. The employment of new 3D cell culture models in combination 

with traditional 2D models and co-culture models of two or more cell types would enable 

more accurate evaluation of drug efficiency and sensitivity, toxicity, resistance for in 

vitro testings before moving into in vivo studies and clinical trials.  

A novel material, copper high aspect ratio structure (CuHARS) which is 

biocompatible, biodegradable and less toxic compared to copper nanoparticles with the 

same amount of copper has the potential to be used as a delivery system for drug 

treatment or tissue engineering. Moreover, a combination of CuHARS and disulfiram 

(DSF) to form DSF metal complex showed significant increase in growth inhibition of 
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gliomas in both 2D and 3D models suggested a promising approach in treating 

glioblastomas.  
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CHAPTER 1 

 

INTRODUCTION 

1.1 Glioblastoma 

Glioblastoma multiforme (GBM), the most common form of brain cancer, is a 

fatal and incurable disease [1].  About 65% of all primary brain tumors are caused by 

GBM and the survival rate is less than 5 years in 90% of patients [2]. Treatments often 

require surgery and chemotherapy, but in most cases, are ineffective [3]. The lack of 

adequate treatment and high recurrence rate is believed to be driven by glioma stem cells 

(GSC), which have the ability to self-renew, are resistant to drugs and are extremely 

invasive [4]. Figure 1.1 shows an example of CRL-2303, a type of immortalized 

glioblastoma grown in traditional 48-wells culture plate. The aforementioned 

characteristics of GSC underscore the need for improved methods to study the 

progression of GBM and its recurrence mechanism and for novel breakthrough therapies 

to prevent GBM recurrence and extend the lives of patients suffering from this fatal 

disease. One of these approaches is to use anticancer drugs with convection-enhanced 

delivery of nanocarriers [5]. The purpose of this study is to examine the novel copper 

high aspect ratio structure biomaterial (CuHARS) as a potential carrier for delivering 

cancer drug in two and three-dimensional cell cultures.  
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Figure 1.1: Glioblastoma (CRL-2303 – ATCC) in cell culture, imaged with phase 

microscopy at 200x magnification. Scale bar = 100 µm. 

1.2 Three-Dimensional Cell Culture Model 

The three-dimensional (3D) cell spheroid model has emerged in recent years as a 

new approach in cell sciences in contrast to traditional two-dimensional (2D) model with 

several advantages. Cell proliferation, morphology, and physiology in the 3D model 

better mimic the tissue micro-environment with potentially three layers of cells 

(proliferating, quiescent and necrotic), growing at different rates, instead of the more 

homogeneous rate in 2D model [6]. One of the most exciting facets of creating in vitro 

3D cancer models is the ability to experimentally manipulate each component of the 

tumor microenvironment to try and understand the drivers of cancer as a disease state. 

Furthermore, diffusion considerations cause the in vitro 3D model to respond more 

accurately to drug treatment than 2D monolayers. Growing cells as 3D spheroids can 

increase resistance to chemotherapy when compared to the same cells grown in 

monolayers. The most straightforward explanation for enhanced resistance is that the 

cells on the inside of the spheroid are protected from drug penetration by the cells on the 
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outside of the spheroid. Another mechanism has been suggested related to the differential 

zones of proliferation [7], [8]. However, 3D cultures take longer time to form, and their 

longer diffusion times slow the effect of drugs. Also, 3D spheroid data needs to be 

normalized (area and volume) to interpret the results. Figure 1.2 illustrates an example of 

3D spheroid developed using a proprietary technique by our lab. 

 

 

Figure 1.2: 3D spheroid of glioblastoma brain tumor cells grown in our lab. Scale bar = 

200 µm. 

1.3 A Novel Biomaterial for Drug Delivery System 

CuHARS is a novel biocomposite made from copper and the amino acid cystine 

which has previously been discovered and published by Dr. DeCoster’s lab at Louisiana 

Tech University [9]. The material has a rod-like shape and has both nano and micro-

features [10], [11]. CuHARS has a vast potential for drug delivery systems because it is 

extremely stable in water but breaks down in cell culture media or when it interacts with 

cells. Biomaterials as a carrier for drug delivery system has been a hot topic in drug 

discovery research for the last three decades [12]. Much work has considered the 
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advantages of different types of biomaterials for targeting tumors and deliver drugs to the 

tumor site; but minimal research considers the fate of the biomaterial after drugs are 

delivered to the tumor and how our bodies dispose of those material [13]. For example, 

halloysite nanotubes (HNTs) which are made from clay, do not break down after entering 

our bodies. CuHARS is thus a great candidate for use in drug delivery research because it 

is confirmed to degrade over time after it is introduced in cell culture media or interacts 

with cells [14]. Figure 1.3 and 1.4 are electron microscope images showing detailed 

structure of the CuHARS with both nano- and micro features. 

 

 

Figure 1.3: SEM images of starting material copper nanoparticles (left), and metallic 

biocomposite structures shown at the micro-scale (middle and right panels). Scale bars 

are 1 µm (left panel) and 5 µm (middle and right panels). 

 

Figure 1.4: TEM images of the bio-metallic composites shown at the nanoscale. Scale 

bars are 50 nm (left panel) and 200 nm (right panel). 
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1.4 Disulfiram as a Potential Cancer Drug 

Disulfiram (DSF) – an FDA approved drug to treat alcoholism, has recently been 

identified as a promising drug for cancer treatment, including GBM [15]. The 

mechanisms of action of DSF are not clearly understood, however research has indicated: 

1) proteasome inhibition; 2) NFkB inhibition; 3) epigenetic alteration; 4) re-sensitizing 

GBM to temozolomide (TMZ); 5) radio-sensitizing GBM cells, and 6) targeting in GSC. 

Figure 1.5 shows the chemical structure of DSF, which can generate copper 

diethyldithiocarbamate (Cu(DDC)2) complex, an active anticancer agent when DSF is 

applied in the presence of copper [16]. 

 

 

Figure 1.5: Disulfiram molecular structure. 

DSF is of interest to this study because data suggest that DSF in the presence of 

copper shows better effects on cancer cells, including the aggressive GBM [17]. Since the 

CuHARS contains copper and degrades over time in vitro, a combination of DSF and 

CuHARS could be a novel therapeutic approach to treat GBM. 
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1.5 Objective of This Study 

The overall goal of this research project is to study the use of a novel matrix free 

three-dimensional spheroid as a new approach to study the interaction of brain cells with 

different biomaterials and drugs.  It will be divided into 3 major objectives: 

Objective 1:  To demonstrate similarity and difference in interaction with 

materials (CuHARS, CuNPs and HNTs) between three-dimensional spheroids compared 

to traditional two-dimensional cell culture. 

Objective 2:  To demonstrate the use of the novel material CuHARS as a 

potential carrier in a delivery system of drug treatment and/or cell growth promotion. 

Objective 3:  To demonstrate a method to modify the CuHARS to get a more 

uniform in size and shape CuHARS for better carrier and interaction with cells as well as 

the degradable ability of CuHARS in cell culture media under physiological conditions. 

1.6 Dissertation Overview 

Chapter 1 reviews the relevance and motivation and research goals of the study. 

Chapter 2 provides the background on the two cell types used in this study, primary 

astrocyte and glioma cells, the two cell culture techniques, traditional two-dimension and 

three-dimensional models together with their advantages and disadvantages. We will also 

discuss a novel technique developed by our group to create a 3D dimensional model. 

Chapter 3 compares two-dimension and three-dimensional models in term of cell 

morphology and interaction with different materials while Chapter 4 provides 

quantitative analysis for toxicity of these materials on both cell types in the two cell 

culture models and considers the potential of a novel biomaterial discovered by our group 

called CuHARS to be used as a delivery system. Chapter 5 describes a method to modify 
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the CuHARS without changing its characteristics for better integration into cell culture. 

Finally, Chapter 6 investigates the technique of cultivating a mixed co-culture model 

(both 2D and 3D) consisting of primary astrocytes and gliomas that can be utilized to 

study tumor invasiveness and cell-cell interactions between different cell populations. 
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CHAPTER 2 

 

BACKGROUND 

2.1 Cells of The Brain: Astrocytes 

The human brain consists of approximately 1012 cells, with the number of neurons 

are considered to be approximately 1011, and the rest being glia (around 9x1011); which 

means glial cells outnumber neurons by 2-9 times in the central nervous system (CNS). 

Astrocytes, one of the major classes of glial cells (along with microglia, oligodendrocytes 

and Schawann cells) outnumber neurons by approximately five fold [18] and derive their 

name from the roughly star-shaped cell bodies with many processes, as shown in Figure 

2.1. Two major types of astrocytes are fibrous astrocytes (found in the white matter), with 

a high number of long processes that contain large bundles of intermediate filaments, and 

Protoplasmic astrocytes (found in the gray matter), with many processes that end in 

sheet-like appendages. Both types of astrocytes have end-feet which contact and surround 

capillaries, arterioles, and neurons throughout the brain. The protoplasmic astrocytes’ 

processes cover nerve cell bodies and synapses, whereas the end-feet of fibrous 

astrocytes contact axons at the nodes of Ranvier [19]. 
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Figure 2.1: Major types of glial cells in the CNS (oligodendrocytes and astrocytes) and 

in the peripheral nervous system (Schwann cells) [19]. 

Although some of the functions of astrocytes are still not fully understood [18], it 

is generally thought that astrocytes are not essential for information processing but 

support, protect neurons, and provide nutrition to the neurons [19], [20]. Astrocytes are 

believed to support neurons in five major ways: 

1. Astrocytes help separate cells, thus insulating neuron cells and their synapses 

from improper interconnections. 

2. Astrocytes are highly permeable to some ions (specifically K+) and thus, they 

help regulate these ion concentrations inside the brain. For example, during an action 

potential, neurons release K+ when they fire. Without astrocytes to take up and regulate 

K+ in the extracellular space, repetitive firing may create excess K+ that could reduce the 

signaling efficiency between neurons. Astrocytes also regulate Ca2+ which is involved in 

neuronal calcium signaling [21], [22]. 

3. Astrocytes uptake neurotransmitters (mainly glutamate, GABA) and recycle 

them for future use by the neurons, and thus support neuronal signaling [23]–[25]. 
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Although astrocytes (and other glial cell types) do not generate action potentials, they 

participate in neuron-glial signaling processes. This signaling is still poorly understood, 

but it is believed to actively help to regulate synapse development and function. 

4. Astrocytes also help nourish surrounding neurons by providing various 

necessary growth factors. Astrocytes express enzymes which are not available in neurons 

and produce metabolic intermediates of several metabolic pathways [26], [27]. 

5. Astrocytes help to control cerebral blood flow and maintaining the blood–brain 

barrier. Astrocytes help regulate local CNS blood flow by having extensive contacts with 

blood vessels and producing and releasing various molecular mediators, such as 

prostaglandins (PGE), nitric oxide (NO), and arachidonic acid (AA), which can cause 

CNS blood vessel to dilate or constrict [18]. The blood–brain barrier (BBB) is composed 

of the blood vessels that vascularize the central nervous system (CNS) and possess 

unique properties to act as a diffusion barrier that tightly regulate the movement of ions, 

molecules, and other substances between the blood and the brain, in order to defend the 

brain from any potential harm circulating in the blood [28], [29]. However, astrocytes’ 

exact role in the BBB, especially in patients with stroke or brain trauma is still poorly 

defined [30]. Recent studies suggested that several factors released by astrocytes might 

be important for the induction and maintenance of the BBB. In particular, transforming 

growth factor alpha (TGF-α) and glial-derived neurotrophic factor (GDNF) are believed 

to support the formation of tight junctions in cultured endothelial cells [28], [31], [32]. 

2.2 Malignant Glioblastoma 

The most common category of brain tumor is brain metastases (or secondary brain 

tumors) which are the spread of a primary tumor to the brain and which account for 10-
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30% of cancer cases [33], [34]. As the name suggested, the cancer cells (lung, breast, 

colon, kidney and melanoma) start from different parts of the body then break off from 

the original mass and move through the bloodstream or lymph system and spread to the 

brain [35].  

In contrast, primary malignant brain and other CNS tumors are rare. The 

incidence of primary brain tumors worldwide is approximately 4 to 10 per 100,000 

individuals per year, and varies up to three fold between countries and ethnic groups 

[36]–[38]. Although brain tumors account for only about 2% of all cancers in adults and 

7% of the years of life lost from cancer before the age of 70, the survival rate of patients 

with brain cancer improves very little or remains unchanged. The length of survival can 

be as short as 9 months in patients with highly invasive tumor types [38], [39]. The 

common gliomas affecting the CNS of adults are often referred to as “diffuse gliomas” 

because they have diffuse infiltrative growth throughout the brain parenchyma [39], [40]. 

Gliomas are classified histologically, immunohistochemically, as astrocytomas, 

oligodendrogliomas and ependymomas as displayed in Figure 2.2, based on cell types 

they originated from (astrocytes, oligodendrocytes and ependymal cells, respectively) in 

which astrocytomas accounts for over 75% of gliomas cases [41]. 



12 

 

Figure 2.2: Cell of Origin for Malignant Gliomas. Neural stem cells (NSCs) differentiate 

into neurons, astrocytes, and oligodendrocyte precursor cells (OPCs). All these three cell 

types can mutate and give rise to malignant gliomas as indicated by dotted red lines [42]. 

Tumors are further categorized by various histopathological features together with 

genetic alterations, based on how differentiated the tumor cells are from the original cells, 

into grade from I to IV as presented in Figure 2.3 [39], [43].  Grade I tumors are slow 

growing, unlikely to spread and mostly benign. They can be cured with surgery and the 

5-year survival rate of patients with grade I tumors is over 90% [44]. Grade II tumors are 

low-grade malignancies which are moderately slow growing but are likely to recur after 

treatment, thus requiring long clinical treatment courses; life expectancy is 5-10 years 

after diagnosis and varies by ages. Grade III tumors demonstrate increased anaplasia 

(hence the alternative name, anaplastic astrocytoma) and proliferation over grade II 

tumors with rapidly dividing cells but little or no necrotic cells, and they are more rapidly 
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fatal than Grade II; life expectancy drops to 2-3 years with 5-year survival rate for 

patients over 55 years old of less than 10% [44], [45]. Grade IV tumors (or glioblastoma) 

exhibit more advanced features of malignancy, invasion including angiogenesis (vascular 

proliferation) and necrosis, as well as resistance to radio/chemotherapy and high 

recurrence rate; the survival rate in all age groups is normally less than 12 months [41], 

[44]–[47]. 

 

 

Figure 2.3: Characteristics, chromosomal and genetic aberrations related as well as 

survival expectancy for Grade II-IV of astrocytoma [39]. 

Type IV glioblastoma, often called glioblastoma multiforme (GBM), represents 

the most malignant, aggressive and fatal type of brain tumor. Primary treatment usually 

consists of surgery followed by radiation and chemotherapy. However, recurrence 

frequently occurs within 6-9 months after treatments [48]–[50]. On top of that, the cause 

for these types of brain tumors is generally unknown. Gene abnormalities are considered 
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to be one of the main factors deciding the progression of tumors, although the mechanism 

that leads to those abnormalities is still unclear.   

Since GBM is derived from astrocytes – the major supportive cell type in brain, 

brain tumors can affect all kinds of brain functions in various areas.  As a brain tumor 

grows, it may over time interfere with many of the normal functions of the brain (Figure 

2.4). One of the first signs of GBM (headaches, seizures or changes in behavior) is 

increased pressure in the brain caused by the inability of the skull to expand to 

accommodate the aggressive growth of a tumor. Weakness or numbness in the arms or 

legs, language dysfunction, blurred vision, cognitive impairments as well as seizure are 

also common [51], [52]. Other symptoms may also occur, depending on the size and 

location of the tumor in addition to the age of patients. 

Glioma brain tumor accounts for almost half of cancer and brain cancer mortality 

rates and in most cases are incurable [37], [39], [47], [50], [53]. Most cytotoxic drugs 

remain ineffective in treatment due to limited passage through the blood brain barrier 

(BBB). Several other limitations include resistance to chemotherapeutic agents and 

efficient DNA repair mechanism. 
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Figure 2.4: GBM can affect different functions of the brain depending on locations and 

size of the tumor [54]. 

2.3 Two Dimensional Versus Three-Dimensional Cell Culture 

Cell-based assays, or in vitro two-dimensional cell cultures have played a vital 

role in the drug discovery process by offering a simple, fast, and cost-effective tool for 

preliminary testing before implementation of complicated and expensive animal testing. 

The term cell culture is used because results are based on the cellular responses (of 

cultured cells) to drugs, materials and other stimuli [6]. 

To date, traditional 2D cell culture is still the most frequently used method in cell 

assay and drug testing in vitro. The reason of its popularity is 2D cell culture presents a 

convenient, cheap and quick way to study drug responses. Cells can be placed on tissue 

culture Petri dishes, polystyrene plastic flasks or well-plates. It also does not require huge 

numbers of cells for experiment, so different combinations of drugs can be tested rapidly. 

In 2D model, cells form a monolayer on the bottom of the wells and all of the cells of 

such layer receive a homogenous amount of nutrients and growth factors from the 

medium during growth [55]. The monolayer also contains very few or no dead cells, but 
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is mainly composed of proliferating cells, because necrotic cells are usually detached 

from the surfaces and easily washed off. Cell morphology in 2D culture is usually flatter 

and more stretched than it is in vivo as shown in the schematic in Figure 2.5. 

Consequently, 2D modeled cells may not respond to drug or other materials the way they 

would inside the body. 

 

 

Figure 2.5: Schematic of cells grow in traditional 2D culture [56], [57]. 

In contrast, cells in 3D cell culture models grow into a spheroid within a matrix, 

scaffolds or suspension environment. Because of the tight contact in spheroids, cell-cell 

interactions and cell-extracellular matrix (ECM) interactions is believed to better mimic 

the microstructure and dynamic biochemistry of living tissues, which in turn can provide 

more accurate response in drug screening [55], [58]. Compared to 2D model, a typical 3D 

spheroid (as displayed in the diagram in Figure 2.6) is made of multiple layers growing 

at different rates, with a typical spheroid composed of proliferating, quiescent and 

necrotic layers [6], [59]. The outer layer, which has access to a maximum amount of 

nutrients and oxygen from the media, consists mostly of viable, proliferating cells (hence 
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the name proliferating layer). Cells in the middle layer still receive nutrients, growth 

factors and oxygen but at lower level than the proliferating layer; thus, cells at this layer 

tend to be less active (quiescent layer). The core layer, on other hand, has almost no 

access to oxygen and nutrients, and consists mainly of dead cells (necrotic layer) [58]–

[60]. 

 

 

Figure 2.6: A typical 3D cell cultured spheroid includes different layers of cells [6]. 

Similar to 2D cell culture, 3D cell culture is also able to grow simultaneously two 

or more different cellular populations (co-cultured spheroid) but it mimics more 

accurately cellular functions normally observed within living tissues [6]. Last but not 

least, the three-dimensional model is considered as a bridge between in vitro and in vivo 

since using 3D cell culture makes it possible to control and monitor the cell spheroid 

micro-environment parameters (spheroid size, nutrients and growth factors, temperature, 

oxygen rate, pH) to a certain extent while remaining as accurate to whole living tissues as 

possible. 
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2.4 3D Cell Culture Techniques 

A broad collection of tools and techniques are available to grow cells into 3D 

structures [6], [7], [61]. They are generally classified into two main categories; scaffold 

and non-scaffold based, and include these common technologies: 

1. Scaffold Based Techniques  

• Polymeric Hard Scaffolds 

• Biologic Scaffolds 

• Micropatterned Surface Microplates 

2. Non-Scaffold Based Techniques 

• Hanging Drop Microplates 

• Spheroid Microplates containing Ultra-Low Attachment (ULA) 

coating 

• Microfluidic 3D Cell Culture 

 Scaffold Based Techniques 

Scaffold based techniques are the ones in which cells are grown with the help of a 

support. The scaffolds act as a physical support system for in vitro cell culture. Scaffold 

techniques also have encouraging application in vivo tissue regeneration because they can 

reconstruct the structural environment of living tissue [62]. 

2.4.1.1 Polymeric Hard Material Scaffolds 

  In polymeric hard material scaffold technique, 3D spheroid models are created by 

cultured cells on pre-fabricated scaffolds, or matrices, in order to mimic the tissue ECM. 

Cells attach, proliferate, and fill the spaces within the scaffold to form 3D structures [63]. 
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Materials used in this technique includes polystyrene (PS) and polycaprolactone (PCL). 

Common designs include porous disc, electro-spun, and orthogonal layering [64]. 

Polymeric hard scaffolds are used in two major areas; regenerative medicine and 

preclinical in vitro study. In regenerative medicine, cells are grown on the scaffold and 

then transplanted to patients to replace degenerative tissue. Presently, scaffolds have been 

used successfully to engineer bone, cartilage, muscle, ligament, skin, vascular tissues and 

macula [65]–[67]. For preclinical in vitro study, cells are grown on the scaffold in Petri 

dishes or well plate for tumors modeling and drug studies. Typical thickness of the final 

scaffold is 150-200 μm; each containing a consistent pore size. 

After scaffolds are incorporated (as shown in Figure 2.7), cells are placed and 

treated using procedures similar to that used with 2D cell culture. The arrangement of 

fibers and pores provides support for the cell to reorganize in three dimensions while it 

provides full access to nutrient, growth factors, and oxygen, allowing exchange of 

nutrients, waste material, and gases similar to that seen in vivo. 
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Figure 2.7: Orthogonal layering polymeric scaffolds for 3D cell spheroid forming (top 

panel) and final joint configuration of polymeric 3D scaffold in 96-wells plate format 

(bottom panel) [64]. 

2.4.1.2 Biological Scaffolds 

A frequently used component of scaffolds is hydrogel, which can be created from 

natural or biological origin (such as proteoglycans, fibrous proteins, collagen, and gelatin 

generally found in the in vivo ECM). Biological scaffolds offer a matrix for cells to attach 

and grow into 3D structures as well as the microenvironment with soluble growth factors, 

hormones, and other nutrients which are often found in in vivo environment [68]. The 

polymer networks used in current hydrogel-based techniques are extensively swollen 

with water. The cells can be mixed with scaffold proteins in a liquid state (hydrogel) 

before they are plated in a microplate well, or they can be added, with nutrient mixture, to 

scaffolds already formed. Since these scaffolds originate from natural sources, they pose 
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low risk of toxicity and harm to cells while promoting many cellular functions, including 

increased viability, cell proliferation and cell formation [6], [7], [69]. In many cases, 

biological scaffolds can also be more advantageous over polymeric hard material 

scaffolds, as the hydrogel scaffolds can be engineered to associate and dissociate at 

biological conditions, unlike polymeric scaffolds (Figure 2.8). Hydrogels are also used in 

multi-layer scaffolds to form tissue-like structures, where each cell type is planted in a 

distinct hydrogel scaffold and the scaffolds are then put together on top of each other. 

Examples are human skin [70] and human corneal limbal crypts [59]. 

 

 

Figure 2.8: An example of hydrogel scaffolds used to encapsulate, grow and release 

multicellular cancer spheroids (MCSs) of MCF-7 cells using cellulose nanocrystals 

(CNCs) [71]. 

2.4.1.3 Micropatterned Surface Microplates 

Use of micropatterned surface plates is a relatively new technique that takes full 

advantage of latest advancement made in micro-fabrication technology. Compartments 

are patterned at micrometer scale on the bottom of the wells in the microplates [64]. 

Wells can have various shapes – square, round, split pattern (Figure 2.9) with different 

configurations optimized for 3D spheroid forming or cell networking interaction.  
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Figure 2.9: Some example of micropatterned surface microplate with different well 

shapes [64]. 

The micro-space compartments in each well are coated to create a low adhesion 

surface to prevent the cells from attaching. Consequently, cells self-assemble to form 3D 

spheroid structures in the compartment, or to form contiguous cell networks in case of the 

slit pattern, along the bottom of the well (Figure 2.9). The latest studies show that cell 

spheroids formed using micropatterned surface microplates demonstrate highly different 

enzyme expression levels and drug response compared to traditional 2D cell culture [72]. 

 Non-Scaffold Based 3D Cell Culture 

2.4.2.1 Hanging Drop Microplates 

The hanging drop plate method is a simple technique that takes advantage of the 

tendency for cells with no nearby adhesion surface to aggregate into a 3D spheroid 

structure. In this method, instead of normal wells with a traditional bottom, the plate is 

equipped with open-bottomed wells. The top of the microplate is just like other 

conventional microplates, where cells and media can be dispensed (Figure 2.10), while a 

discrete droplet of media sufficient for cellular aggregation forms at the bottom opening 

of the well due to surface tension [64], [73]. 
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Figure 2.10: Diagram of hanging drop microplates [73]. 

This method allows the spheroid size to be controlled by adjusting the number of 

cells placed into each drop. Co-cultured spheroids with separate layers of multiple cell 

types can also be formed with no specialized equipment required except the hanging drop 

plate. The drawback of this technique is mobility, as the drops are susceptible to small 

mechanical shocks which cause spilling of the media and disruption of spheroids 

formation. Also, for long-term experiments (which is one of the benefits of 3D model 

over 2D model), spheroids need to be transferred to a second plate containing larger 

amount of media to prevent drying out as each drop contains limited amount of media. 

2.4.2.2 Spheroid Microplates Containing Ultra-Low Attachment Coating 

Ultra-low attachment (ULA) plates are an alternative to the hanging drop method. 

A 96- or 384-well microplate is commonly used in this method. The ultra-low attachment 

surface prevents cell adherence without the need for additional coating and allows a 3D 

spheroid structure to form. The bottom of each well is rounded instead of flat to conform 

better to the round multi-cell tissue or tumor spheroid structure. Well bottoms with v-

shaped geometry design ensure formation of the spheroids in the middle of the well 

(Figure 2.11). Since the cells still have access to large amount of media and growth 
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factors, long-term experiment can be carried out in the same plate; without the need for 

transfer to a second one [64], [74]. Current research that employs ULA coating 

microplate include neural stem cell spheroid [75] and various immortalized cancer cell 

lines spheroids for drug screening [74], [76]. 

 

 

Figure 2.11: Ultra-low attachment (ULA) 96-well round-bottomed plates were used to 

generate suspension cultures of reproducibly sized, single spheroids in each well [74]. 

2.4.2.3 Microfluidic 3D Cell Culture 

One of the ultimate goals of the 3D cell spheroid model as described above is to 

recreate the three-dimensional structure of living tissues and tumors and to allow cell-cell 

and cell-ECM interactions. In this method, microfluidic platforms are used to create a 

spheroid of one or more cell types (co-culture), while introducing a perfusive flow aspect 

to the cellular environment (Figure 2.12); permitting continuous addition of nutrition and 

oxygen as well as introduction of chemicals or drugs [73], [76], [77]. 
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Figure 2.12: Diagram of a microfluid design of 3D spheroid model for drug screening 

[77]. 

Microfluidic devices use physical barriers composed of glass, silicon, and 

polymers, including polydimethylsiloxane (PDMS), polymethylmethacrylate (PMMA), 

polycarbonate (PC) and polystyrene (PS) [73]. Supporting matrix (such as collagen) can 

also be used to help 3D spheroid assembly and promote cell-cell and cell-ECM 

interactions. Current research directions that employs microfluidic systems include bone 

marrow mesenchymal stem cells (BMSCs) [78], murine embryonic stem cells [79], and 

carcinoma-associated fibroblasts invasion [80].  

2.5 A Novel Matrix Free Spheroid Technique 

 Introduction 

A matrix-free method is used in this study to create 3D spheroids of various cell 

types, including primary astrocyte cells, glioma brain tumor cells, and primary 

endothelial cells. This technique provides a simple but efficient, cost-effective method to 
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generate 3D spheroids that does not require matrix, scaffolds, or expensive plates but still 

retains the benefits of 3D cell models, including co-culturing of spheroids of different cell 

types, drug screening, and long-term interaction with biomaterial. Here we use a 

proprietary technique (Provisional patent number 61645328, filed with the U.S. Patent 

office) that uses a matrix-free system (Nanogaia #SSD-01, Ruston, LA - 

http://www.nanogaia.com/) with standard suspension cell culture plate. Also, this 

technique does not require special cell culture media and can be used for long periods of 

time after coating to enable much longer-term experiments than traditional 2D cell 

model. Since this method does not require any specialized equipment or techniques, it is 

suitable for both high-throughput studies (best for drug screening), and high-content 

studies (best for study cell interaction with drugs and biomaterials). The lack of a solid 

matrix provides the freedom to manipulate spheroids in our system in many ways.  

 Advantages of Our System 

The system is advantageous in that it 

• Provides matrix free generation of spheroids. 

• Is simple and inexpensive. 

• Can produce spheroids in large numbers. 

• Can co-culture spheroids of two or more different cell types. 

• Allows long term cell culture (up to one month compared to 3-7 days in 

2D models). 

• Has a wide variety of application, not limited to cell culture studies [81]. 

http://www.nanogaia.com/
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2.6 Comparison of CuHARS, CuNPs and HNTs 

 Copper nanoparticles (CuNPs) used in this research are copper based particles 

with size within range from 40-60 nm and have antifungal/antibacterial features due to 

their nano size and a high surface to volume ratio [82]. The stress/toxicity of CuNPs is 

produced when they interact with the membranes of cells/microbial and release metal 

ions into medium. Halloysite nanotubes (HNTs) are aluminosilicate clay mineral 

(chemical formula: Al2Si2O5(OH)4) and have hollow tubular structure with outer diameter 

50 ± 5 nm; inner lumen 10 - 15 nm; and length 1200 ± 300 nm. The outer surface of 

HNTs is negative charged while the inner core is positive charged. Materials such as 

proteins, DNA, cancer drugs can be loaded to the hollow lumen of HNTs and then 

released in a controlled manner [83], [84]. CuHARS as previously described, is a self-

assembled copper-containing biohybrid with the amino acid dimer cystine that forms 

high-aspect ratio structures [9]–[11], [14]. CuHARS has both bio-compatible and bio-

degradable features which makes it a potential candidate to be used as a delivery system 

for drug treatments and/or cell growth promotions. Structure comparison of three 

materials using scanning electron microscopy (SEM) is shown in Figure 2.13. 

 

 

Figure 2.13: Side by side comparison of three materials, CuHARS (left panel), CuNPs 

(middle panel) and HNTs (right panel). Scale bars = 5 µm (left panel) and 1 µm (middle 

and right panels) [10], [85].  
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CHAPTER 3 

 

COMPARISON OF TWO-DIMENSIONAL AND THREE- 

 

DIMENSIONAL CELL MODELS 

3.1 Introduction 

As previous described, three-dimensional (3D) cell models hold several 

advantages over traditional two-dimensional (2D) cell culture. In particularly, they more 

accurately mimic cell morphology, cell-cell interaction, and cell-ECM interaction in 

living tissues, which in turn provides a better response in drug screening, and allows 

performance of a much longer-term experiment than 2D model, which can give more 

insights into how the cells interact with biomaterials.  

The goal of this chapter is to demonstrate the difference between two-dimensional 

and three-dimensional cell models in cell morphology, growth, and interaction with 

materials (Copper nanoparticles – CuNPs, Copper High Aspect Ratio Structure – 

CuHARS [9]–[11] and halloysite nanotubes – HNTs). The study results will allow us to 

better understand cell behavior in different environments before going to in vivo. 

3.2 Materials and Methods 

3.2.1 Cell Types 

Rat brain glioma cells CRL-2303 (C6/lacZ7) were obtained from American Type 

Culture Collection (ATCC) and cultured in CRL-2303 media containing 10% FBS, 1% 
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non-essential amino acid solution, and 0.5% penicillin/streptomycin (Appendix A, 

Section A.1). 

Astrocytes derived from primary, newborn Sprague/Dawley rat brain cortices 

were cultured in astrocyte medium (Ham’s F-12K) containing 10% Horse serum and 

other components (Appendix A, Section A.2). 

3.2.2 Methods 

To test the difference between the way 2D and 3D cell models interact with 

biomaterials, normal brain astrocytes and brain tumor cells were plated in a cell culture 

48 wells plate at the density of 20,000 cells/mL (astrocyte) and 10,000 cells/mL (brain 

tumor) in 2D model and grown in an incubator with 5% CO2 and at 37°C for 5 days in 

vitro (DIV) in case of primary astrocytes and 3 DIV with glioma cells before adding the 

biomaterials. 

Normal brain astrocytes and brain tumor cells were grown in suspension with a 

density of 200,000 cells/mL in 3D model. After cell spheroids were developed for 7 DIV, 

biomaterials were added to the fully formed spheroids at different concentrations. 

3.2.3 Materials  

Three different types of materials were used to study the difference in cell-

materials interaction in both models, copper nanoparticles (CuNPs) (Sigma, 50-100 nm 

in diameter), copper high aspect ratio structure (CuHARS) and halloysite nanotubes 

(HNTs). 
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3.2.4 DAPI Staining 

DAPI (4,6-Diamidino-2-phenylindole, dihydrochloride) was prepared according 

to Appendix E to stain nuclei as a way to confirm cell viability and compare nuclei of 

primary astrocytes and gliomas. 

3.2.5 Microscopy 

A Leica DMI 6000B inverted microscope was used to collect bright field and 

phase microscopic images of the cells. For fluorescent imaging, a Leica EL6000 light 

source was used. For GFAP imaging, excitation in the blue portion of the light spectrum 

(~475 nm) was required. To view DAPI-stained nuclei, excitation light in the ultraviolet 

range (~400 nm) was required.  

3.3 Results 

 Interactions of Materials with Cells in 2D Model 

3.3.1.1 Interaction with CuHARS 

Figure 3.1 and 3.2 show the interaction of primary astrocytes with different 

concentrations of CuHARS over time. Phase microscopy was used to record the cells, 

while bright field microscopy was used to capture the CuHARS with better contrast, as 

needed because the material consists of both copper metal and the amino acid cystine). 
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Figure 3.1: Interaction of CuHARS (1 µg/ml concentration) with primary astrocytes. 

Cells were plated at 20k cells/well and CuHARS were added 5 days after cells attached. 

Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1 were taken using 

phase microscopy, pictures A2, B2, C2 were taken using bright field microscopy. 

Pictures were taken at 0h (left), 24 (center) and 96h (right) post addition at 200x 

magnification. Red arrows indicate CuHARS. Scale bar = 100 µm. 

 

Figure 3.2: Interaction of CuHARS (10 µg/ml concentration) with primary astrocytes. 

Cells were plated at 20k cells/well and CuHARS were added 5 days after cells attached. 

Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1 were taken using 

phase microscopy, pictures A2, B2, C2 were taken using bright field microscopy. 

Pictures were taken at 0h (left), 24 (center) and 96h (right) post addition at 200x 

magnification. Red arrows indicate CuHARS. Scale bar = 100 µm. 
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As shown in Figure 3.1 and 3.2, CuHARS started to bind to the astrocytes as 

soon as the 24h timepoint, and the small CuHARS started to break down at the 96h 

timepoint, as indicated by the smaller CuHARS disappearing in panel C2 (96h) compared 

to panel A2 (0h) in both Figure 3.1 and 3.2. 

Figure 3.3 displays the astrocytes 4 DIV after interaction with the CuHARS at 

different concentrations. In the low and medium concentration 1 and 5 µg/ml (panel B 

and C), the astrocytes showed little to no sign of stress or toxicity (cell loss). 

 

 

Figure 3.3: Interaction of CuHARS with primary astrocytes. Cells were plated at 20k 

cells/well and CuHARS were added 5 days after cells attached. Pictures were taken 96h 

post addition: control (panel A), 1 µg/ml CuHARS (panel B), 5 µg/ml CuHARS (panel 

C) and 10 µg/ml CuHARS (panel D) using phase microscopy at 200x magnification. 

Scale bar = 100 µm. 

The same experiment was also carried out with glioma cells. Figure 3.4 and 3.5 

show the interaction of glioma cells with different concentrations of CuHARS over time. 

At low concentration (1 µg/ml), as in the case of primary astrocytes, CuHARS appeared 
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to be non-toxic to glioma cells, as indicated by the increase in cell number and the change 

in media color from red to yellow, an indicator of cell metabolism (Figure 3.4 panel C1). 

At high concentration (10 µg/ml) as displayed in Figure 3.5 panel C1, the media color 

was not as yellow as it was at low concentration. However, the cells had a similar 

morphology at both low and high CuHARS concentration, which suggested that even at 

high concentration, CuHARS did not cause drastic stress to the cells. 

 

 

Figure 3.4: Interaction of CuHARS (1 µg/ml concentration) with brain tumor cells. Cells 

were plated at 10k cells/well and CuHARS were added 2 days after cells attached. Panels 

1 and 2 were taken of the same areas with pictures A1, B1, C1 were taken using phase 

microscopy, pictures A2, B2, C2 were taken using bright field microscopy. Pictures were 

taken at 0h (left), 24 (center) and 96h (right) post addition at 200x magnification. Red 

arrows indicate CuHARS. Scale bar = 100 µm. 
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Figure 3.5: Interaction of CuHARS (10 µg/ml concentration) with brain tumor cells. 

Cells were plated at 10k cells/well and CuHARS were added 2 days after cells attached. 

Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1 were taken using 

phase microscopy, pictures A2, B2, C2 were taken using bright field microscopy. 

Pictures were taken at 0h (left), 24 (center) and 96h (right) post addition at 200x 

magnification. Red arrows indicate CuHARS. Scale bar = 100 µm. 

Figure 3.4 and Figure 3.5 also show that with tumor cells, as with primary 

astrocytes, CuHARS started to bind to the cells as soon as 24h timepoint and the small 

CuHARS started to break down at 96h timepoint, as shown by the clearing of smaller 

CuHARS in panel C2 (96h) compared to panel A2 (0h) in both figures. 

Side by side comparison of glioma 4 DIV after interaction with the CuHARS is 

displayed in Figure 3.6 at low and medium concentrations of CuHARS (1 µg/ml and 5 

µg/ml). The CuHARS showed little to no toxicity toward the brain tumor cells, indicated 

by the media color turning to yellow (acidic) as the result of high cell metabolism. In 

high concentrations of CuHARS (10 µg/ml), the cells appeared to be stressed and under 

toxicity as the media remained reddest as well as the biggest gap in cell growth. In 
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contrast, the control media had the yellowest color and the shortest gap in cell growth 

since the cells were the healthiest. 

 

 

Figure 3.6: Interaction of CuHARS with brain tumor cells. Cells were plated at 10k 

cells/well and CuHARS were added 2 days after cells attached. Pictures were taken 96h 

post addition: control (panel A), 1 µg/ml CuHARS (panel B), 5 µg/ml CuHARS (panel 

C) and 10 µg/ml CuHARS (panel D) using phase microscopy at 200x magnification. 

Scale bar = 100 µm. 

3.3.1.2 Interaction with CuNPs 

Figure 3.7 and 3.8 show the interaction of primary astrocytes with different 

concentrations of CuNPs over time. Phase microscopy was used to record the cells, while 

bright field microscopy was used to capture the CuNPs with better contrast. 
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Figure 3.7: Interaction of CuNPs (0.5 µg/ml concentration) with primary astrocytes. 

Cells were plated at 20k cells/well and CuNPs were added 5 days after cells attached. 

Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1 were taken using 

phase microscopy, pictures A2, B2, C2 were taken using bright field microscopy. 

Pictures were taken at 0h (left), 3h (center) and 24h (right) post addition at 200x 

magnification. Red arrows indicate CuNPs. Scale bar = 100 µm. 

 

Figure 3.8: Interaction of CuNPs (5 µg/ml concentration) with primary astrocytes. Cells 

were plated at 20k cells/well and CuNPs were added 5 days after cells attached. Panels 1 

and 2 were taken of the same areas with pictures A1, B1, C1 were taken using phase 

microscopy, pictures A2, B2, C2 were taken using bright field microscopy. Pictures were 

taken at 0h (left), 3h (center) and 24h (right) post addition at 200x magnification. Red 

arrows indicate CuNPs. Scale bar = 100 µm. 
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As shown in Figure 3.7 and Figure 3.8, CuNPs break down begins rapidly, 

completing in 3 h for the low concentration (0.5 µg/ml) and after 24 h for all 

concentrations. Also, the CuNPs appeared to be very toxic to the astrocytes as the cells at 

both low and high concentrations (0.5 µg/ml and 5 µg/ml, respectively) of CuNPs already 

showed signs of stress at 24h timepoint. 

Side by side comparison of primary astrocyte 4 DIV after interaction with the 

CuNPs is shown in Figure 3.9. All concentrations of CuNPs (0.5 µg/ml, 2.5 µg/ml, and 5 

µg/ml) caused stress to the astrocytes, as indicated by the cells becoming round and 

shrunken. In contrast, the low and medium concentrations of CuHARS (1 µg/ml and 5 

µg/ml) showed little to no toxicity toward the brain tumor cells (as shown in Figure 3.3). 

 

 

Figure 3.9: Interaction of CuNPs with primary astrocytes. Cells were plated at 20k 

cells/well and CuNPs were added 5 days after cells attached. Pictures were taken 96h 

post addition: control (panel A), 0.5 µg/ml CuNPs (panel B), 2.5 µg/ml CuNPs (panel C) 

and 5 µg/ml CuNPs (panel D) using phase microscopy at 200x magnification. Scale bar = 

100 µm. 
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Figure 3.10 and 3.11 show the interaction of glioma cells with different 

concentrations of CuNPs over time. Both low and high concentrations (0.5 µg/ml and 5 

µg/ml) of CuNPs broke down entirely within 3h for the low concentration (0.5 µg/ml) 

and within 24h for all concentrations similar to the case of primary astrocytes. 

  

 

Figure 3.10: Interaction of CuNPs (0.5 µg/ml concentration) with brain tumor cells. 

Cells were plated at 20k cells/well and CuNPs were added 5 days after cells attached. 

Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1 were taken using 

phase microscopy, pictures A2, B2, C2 were taken using bright field microscopy. 

Pictures were taken at 0h (left), 3h (center) and 24h (right) post addition at 200x 

magnification. Red arrows indicate CuNPs. Scale bar = 100 µm. 
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Figure 3.11: Interaction of CuNPs (5 µg/ml concentration) with brain tumor cells. Cells 

were plated at 20k cells/well and CuNPs were added 5 days after cells attached. Panels 1 

and 2 were taken of the same areas with pictures A1, B1, C1 were taken using phase 

microscopy, pictures A2, B2, C2 were taken using bright field microscopy. Pictures were 

taken at 0h (left), 3h (center) and 24h (right) post addition at 200x magnification. Red 

arrows indicate CuNPs. Scale bar = 100 µm. 

Figure 3.10 and 3.11 also indicate that the CuNPs cause some stress to the glioma 

cells at both concentrations (0.5 µg/ml and 5 µg/ml) as the cells became stressed 

(distinguished by the round shape and shrunk cell body) at the 24h timepoint (panel C1 of 

both figures). 

Side by side comparison of glioma cells 4 DIV after interaction with the CuNPs is 

shown in Figure 3.12. Medium and high concentrations of CuNPs (2.5 µg/ml and 5 

µg/ml) caused stress to the astrocytes, as indicated by the cells becoming round and 

shrinking, but at the low concentration of CuNPs (0.5 µg/ml), glioma cells recovered 

from initial stress, as indicated by the cell proliferation. However, compared to the 

CuHARS with the same amount of copper (as shown in Figure 3.6), CuNPs appeared to 

be more toxic toward the brain tumor cells as cell number goes down and the colors of 
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the media in all concentrations of CuNPs are redder than the colors of the media with 

respective concentrations of CuHARS. Thus, cell metabolism went decreased more by 

stress/toxicity caused by CuNPs than by CuHARS. 

 

 

Figure 3.12: Interaction of CuNPs with brain tumor cells. Cells were plated at 10k 

cells/well and CuNPs were added 5 days after cells attached. Pictures were taken 96h 

post addition: control (panel A), 0.5 µg/ml CuNPs (panel B), 2.5 µg/ml CuNPs (panel C) 

and 5 µg/ml CuNPs (panel D) using phase microscopy at 200x magnification. Scale bar = 

100 µm. 

3.3.1.3 Interaction with HNTs 

Figure 3.13 and 3.14 show the interaction of primary astrocytes with different 

concentrations of HNTs over time. Phase microscopy was used to record the cells, while 

fluorescent microscopy was used to capture the HNTs (green color on black background). 

The figures show that the fluorescent HNTs were taken up by or bound to the primary 

astrocytes over time, as indicated by the clearance in background and the amount of 

HNTs bound on or around the cells at 96h timepoint compared to 0h timepoint. Also, 
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HNTs at high concentration (10 µg/ml) appeared to be toxic to the astrocytes, as shown at 

96h timepoint, as indicate by the rounder shape and shrunken size. 

 

 

Figure 3.13: Interaction of fluorescent HNTs (1 µg/ml concentration) with primary 

astrocytes. Cells were plated at 20k cells/well and HNTs were added 5 days after cells 

attached. Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1 were 

taken using phase microscopy, pictures A2, B2, C2 were taken using fluorescent 

microscopy. Panel 3 is the combination of panels 1 and 2. Pictures were taken at 0h (left), 

24h (center) and 96h (right) post addition at 200x magnification. Red arrows indicate 

fluorescent HNTs. Scale bar = 100 µm. 
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Figure 3.14: Interaction of fluorescent HNTs (10 µg/ml concentration) with primary 

astrocytes. Cells were plated at 20k cells/well and HNTs were added 5 days after cells 

attached. Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1 were 

taken using phase microscopy, pictures A2, B2, C2 were taken using fluorescent 

microscopy. Panel 3 is the combination of panels 1 and 2. Pictures were taken at 0h (left), 

24h (center) and 96h (right) post addition at 200x magnification. Red arrows indicate 

fluorescent HNTs. Scale bar = 100 µm. 

Primary astrocytes 4 DIV after interaction are compared side-by-side for the 

different concentrations of fluorescent HNTs in Figure 3.15 as most of the materials 

were taken up by the cells. A low concentration of HNTs (1 µg/ml) was not toxic to the 

astrocytes while medium and high HNTs concentrations (5, 10 µg/ml) caused some stress 

to the cells as indicated by the shrunken cell bodies (Figure 3.15 panel C, D). 
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Figure 3.15: Interaction of fluorescent HNTs with primary astrocytes. Cells were plated 

at 20k cells/well and HNTs were added 5 days after cells attached. Pictures were taken 

96h post addition: control (panel A), 1 µg/ml HNTs (panel B), 5 µg/ml HNTs (panel C) 

and 10 µg/ml HNTs (panel D) using phase and fluorescent microscopy at 200x 

magnification. Scale bar = 100 µm. 

The same experiment was also carried out with glioma cells and fluorescent 

HNTs.  Figure 3.16 and 3.17 show the interaction of glioma cells with different 

concentrations of HNTs over time. As in the case with the astrocytes, phase microscopy 

was used to record the cells, while fluorescent microscopy was used to capture the HNTs 

(green color on black background). 
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Figure 3.16: Interaction of fluorescent HNTs (1 µg/ml concentration) with brain tumor 

cells. Cells were plated at 10k cells/well and HNTs were added 2 days after cells 

attached. Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1 were 

taken using phase microscopy, pictures A2, B2, C2 were taken using fluorescent 

microscopy. Panel 3 is the combination of panels 1 and 2. Pictures were taken at 0h (left), 

24h (center) and 96h (right) post addition at 200x magnification. Red arrows indicate 

fluorescent HNTs. Scale bar = 100 µm. 
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Figure 3.17: Interaction of fluorescent HNTs (10 µg/ml concentration) with brain tumor 

cells. Cells were plated at 10k cells/well and HNTs were added 2 days after cells 

attached. Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1 were 

taken using phase microscopy, pictures A2, B2, C2 were taken using fluorescent 

microscopy. Panel 3 is the combination of panels 1 and 2. Pictures were taken at 0h (left), 

24h (center) and 96h (right) post addition at 200x magnification. Red arrows indicate 

fluorescent HNTs. Scale bar = 100 µm. 

Figure 3.16 and Figure 3.17 show that the fluorescent HNTs were also taken up 

by or bound to the cancer cells over time, as indicated by the amount of HNTs bound on 

or around the cells at 96h timepoint compared to 0h timepoint. Unlike the astrocytes, 

fluorescent HNTs did not appear to cause any stress to the cancer cells at both low and 

high concentrations.  

 Side by side comparison of glioma cells 4 DIV after interaction with the different 

concentrations of fluorescent HNTs is shown in Figure 3.18. Most of the materials were 
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taken up by or bound to the cells. All concentrations of HNTs (1, 5 and 10 µg/ml) were 

not toxic to the cancer cells as indicated by cell proliferation and no round/shrunk cells 

(Figure 3.18 panel B, C, D). 

 

 

Figure 3.18: Interaction of fluorescent HNTs with brain tumor cells. Cells were plated at 

10k cells/well and HNTs were added 2 days after cells attached. Pictures were taken 96h 

post addition: control (panel A), 1 µg/ml HNTs (panel B), 5 µg/ml HNTs (panel C) and 

10 µg/ml HNTs (panel D) using phase microscopy at 200x magnification. Scale bar = 

100 µm. 

 Interactions of Materials with Cells in 3D Model 

3.3.2.1 3D Spheroid Forming 

An example of a 3D spheroid assembled using the Nanogaia kit is shown in 

Figure 3.19. The kit allowed the spheroid (made from primary astrocyte in this case) to 

form in less than 24h. 
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Figure 3.19: 3D spheroid of primary astrocyte cells made using matrix free method. (5 

DIV spheroid treated with CuNPs 5 µg/ml 2 DIV post treatment). Scale bar = 100 µm. 

A single 3D spheroid can consist of tens of thousands to hundreds of thousands of 

cells and can be up to a millimeter in diameter, which is big enough to see with naked 

eye, without help of microscopy. The traditional 2D model required much less material 

compared to the 3D model because the surface area is larger and the smaller cell 

population smaller. In contrast, 3D spheroids generally require more material (higher 

concentrations) due to larger number of cells and the need for materials to diffuse through 

multiple layers of cells (proliferating, quiescent, necrotic) [86], [87]. 

 A time series that shows the formation of glioma cells into 3D spheroids in less 

than 24h is shown in Figure 3.20.  Figure 3.21 shows the gradual shape change of the 3D 

spheroid over a span of 15 days (2 days interval). 
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Figure 3.20: Time series of CRL-2303 spheroid (200,000 cells per ml) forming using 

Nanogaia #SSD-01 kit at 1h (panel A), 2h (panel B), 3h (panel C), 4h (panel D), 6h 

(panel E), 24h (panel F). Scale bar = 100 µm. 

 

Figure 3.21: Time series of CRL-2303 spheroid growth (200,000 cells per ml) over 15 

days (7 div – 21 div). Scale bar = 200 µm. 

3.3.2.2 Interaction with CuHARS 

Figures 3.22 and 3.23 show the interaction of a 3D spheroid of primary astrocytes 

with different concentrations of CuHARS over time. Phase microscopy was used to 

record the cells, while bright field microscopy was used to capture the CuHARS with 

better contrast.  The CuHARS started to bind to the outer layer of the astrocyte spheroid 
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as early as 4h post addition. At low concentration (5 µg/ml), most of the CuHARS bound 

to the spheroid or were broken down (Figure 3.22 panel D, E, F) as there was no free 

CuHARS in the media after 6 days. 

 

 

Figure 3.22: Interaction of CuHARS (5 µg/ml) with the astrocyte spheroids. CuHARS 

were added 5 days after the spheroids were formed. Pictures were taken at 4h (panel A), 1 

DIV (panel B), 2 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 DIV (panel F) 

post addition of CuHARS using bright field microscopy at 100x magnification. Red 

arrows indicate association of CuHARS with cell spheroid. Note breakdown/clearance of 

CuHARS from the media over time. Scale bar = 100 µm. 
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Figure 3.23: Interaction of CuHARS (25 µg/ml) with the astrocyte spheroids. CuHARS 

were added 5 days after the spheroids were formed. Pictures were taken at 4h (panel A), 1 

DIV (panel B), 2 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 DIV (panel F) 

post addition of CuHARS using bright field microscopy at 100x magnification. Red 

arrows indicate association of CuHARS with cell spheroid. Scale bar = 100 µm. 

The same experiment was also carried out with glioma cells. Figures 3.24 and 

3.25 show the interaction of glioma cells with different concentrations of CuHARS over 

time.  Similar to the primary astrocytes, CuHARS clearance occurs at low concentration 

(5 µg/ml) as most of the CuHARS bound to or near the spheroid were broken down 

(Figure 3.24 panel D, E, F) and no free CuHARS were present in the media after 6 days. 

A low concentration of CuHARS appeared to be initially less toxic to the 3D glioma 

spheroid, as indicated by the media color change from red to yellow at 4 and 6 DIV, a 

sign of normal cell metabolism, while high concentration (25 µg/ml) of CuHARS showed 

indication of toxicity as the color of the media did not change over the course of the 

experiment. Moreover, both low and high concentration of CuHARS appeared to be toxic 

to the spheroid at 10 DIV timepoint. 
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Figure 3.24: Interaction of CuHARS (5 µg/ml) with the brain tumor spheroids. CuHARS 

were added 5 days after the spheroids were formed. Pictures were taken at 4h (panel A), 1 

DIV (panel B), 2 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 DIV (panel F) 

post addition of CuHARS using bright field microscopy at 100x magnification. Red 

arrows indicate association of CuHARS with cell spheroid. Note breakdown/clearance of 

CuHARS from the media over time. Scale bar = 100 µm. 

 

Figure 3.25: Interaction of CuHARS (25 µg/ml) with the brain tumor spheroids. 

CuHARS were added 5 days after the spheroids were formed. Pictures were taken at 4h 

(panel A), 1 DIV (panel B), 2 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 

DIV (panel F) post addition of CuHARS using bright field microscopy at 100x 

magnification. White arrows indicate association of CuHARS with cell spheroid. Note 

breakdown/clearance of CuHARS over time. Scale bar = 100 µm. 



52 

3.3.2.3 Interaction with CuNPs 

Figure 3.26 and 3.27 show the interaction of primary astrocytes spheroid with 

different concentrations of CuNPs over time. Phase microscopy was used to record the 

cells, while bright field microscopy was used to capture the CuNPs with better contrast.  

CuNPs at low concentration of 2.5 µg/ml degraded completely within 5h of treatment, 

while at a higher concentration of 12.5 µg/ml were still present after 5h of treatment but 

were broken down completely within 24h of treatment. A high concentration (12.5 

µg/ml) of CuNPs appeared to be toxic to the spheroid at the 4, 6 and 10 DIV timepoints, 

as indicated by the large amount of cell debris presented around the spheroid and the 

rough edge of the spheroid itself (Figure 3.27 panel D, E, F), compared to little cell 

debris and the smooth edge of the spheroid (Figure 3.26 panel D, E, F). The cell debris 

and rough edge are present because most of the CuNPs came into contact with cells from 

the proliferating layer (the outer layer) of the spheroid, causing those cells to become 

stressed and undergo apoptosis/necrosis. 
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Figure 3.26: Interaction of CuNPs (2.5 µg/ml) with the astrocyte spheroids. CuNPs were 

added 5 days after the spheroids were formed. Pictures were taken at 0h (panel A), 5h 

(panel B), 1 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 DIV (panel F) post 

addition of CuNPs using bright field microscopy at 100x magnification. Red arrows 

indicate CuNPs in media. Scale bar = 100 µm. 

 

Figure 3.27: Interaction of CuNPs (12.5 µg/ml) with the astrocyte spheroids. CuNPs 

were added 5 days after the spheroids were formed. Pictures were taken at 0h (panel A), 

5h (panel B), 1 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 DIV (panel F) 

post addition of CuNPs using bright field microscopy at 100x magnification. Red arrows 

indicate CuNPs in media. Scale bar = 100 µm. 
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The same experiment was also carried out with glioma cells. Figure 3.28 and 3.29 

show the interaction of glioma cells with different concentrations of CuNPs over time. 

Both low and high concentrations (2.5 µg/ml and 12.5 µg/ml) of CuNPs broke down 

rapidly, with complete break down in 5h for the low concentration (2.5 µg/ml) and 24h 

for all concentrations similar to the case with primary astrocytes. At both concentrations 

of CuNPs, media color changed to yellow toward the end of the experiment, indicating 

that brain tumor cells survived and recovered (cell metabolism went up) even at high 

concentration of CuNPs. 

 

 

Figure 3.28: Interaction of CuNPs (2.5 µg/ml) with the brain tumor spheroids. CuNPs 

were added 5 days after the spheroids were formed. Pictures were taken at 0h (panel A), 

5h (panel B), 1 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 DIV (panel F) 

post addition of CuNPs using bright field microscopy at 100x magnification. White 

arrows indicate CuNPs in media. Scale bar = 100 µm. 
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Figure 3.29: Interaction of CuNPs (12.5 µg/ml) with the brain tumor spheroids. CuNPs 

were added 5 days after the spheroids were formed. Pictures were taken at 0h (panel A), 

5h (panel B), 1 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 DIV (panel F) 

post addition of CuNPs using bright field microscopy at 100x magnification. White 

arrows indicate CuNPs in media. Scale bar = 100 µm. 

3.3.2.4 Interaction with HNTs 

Figure 3. 30 and 3.31 show the interaction of primary astrocytes spheroid with 

different concentrations of HNTs over time. Phase microscopy was used to record the 

cells, while fluorescent microscopy was used to capture the HNTs then both pictures of 

the same area were combined into one panel. As with the 2D cell culture model, the 

fluorescent HNTs quickly started to attach to the astrocyte spheroid and the amount of 

HNTs bound to the spheroid kept increasing over time as indicated by the area of the 

spheroid cover by the fluorescent HNTs grew while the amount of HNTs in the media 

decreased. 
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Figure 3.30: Interaction of fluorescent HNTs (5 µg/ml) with the astrocyte spheroids. 

HNTs were added 5 days after the spheroids were formed. Pictures were taken at 4h 

(panel A), 1 DIV (panel B), 2 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 

DIV (panel F) post addition of HNTs using bright field microscopy at 100x 

magnification. Red arrows indicate association of HNTs with cell spheroid. Scale bar = 

100 µm. 

 

Figure 3.31: Interaction of fluorescent HNTs (25 µg/ml) with the astrocyte spheroids. 

HNTs were added 5 days after the spheroids were formed. Pictures were taken at 4h 

(panel A), 1 DIV (panel B), 2 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 

DIV (panel F) post addition of HNTs using bright field microscopy at 100x 

magnification. Red arrows indicate association of HNTs with cell spheroid. Scale bar = 

100 µm. 
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The same experiment was also carried out with glioma cells and fluorescent 

HNTs. Figure 3.32 and 3.33 shows the interaction of glioma cells with different 

concentrations of HNTs over time. As with the case of astrocytes, phase microscopy was 

used to record the cells, while fluorescent microscopy was used to capture the HNTs. 

Both pictures of the same area were then combined into one panel. As in the primary 

astrocyte model (Figure 3.30 and Figure 3.31) the fluorescent HNTs quickly started to 

attach to the glioma spheroid, and the amount of HNTs bound to the spheroid kept 

increasing over time (Figure 3.32 and Figure 3.33 panel E, F). Note the different z-plane 

focus due to the three-dimensional feature of the spheroid compared to the relatively flat 

two-dimensional cell culture. 

 

 

Figure 3.32: Interaction of fluorescent HNTs (5 µg/ml) with the brain tumor spheroids. 

HNTs were added 5 days after the spheroids were formed. Pictures were taken at 4h 

(panel A), 1 DIV (panel B), 2 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 

DIV (panel F) post addition of HNTs using bright field microscopy at 100x 

magnification. Red arrows indicate association of HNTs with cell spheroid. Scale bar = 

100 µm. 
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Figure 3.33: Interaction of fluorescent HNTs (25 µg/ml) with the brain tumor spheroids. 

HNTs were added 5 days after the spheroids were formed. Pictures were taken at 4h 

(panel A), 1 DIV (panel B), 2 DIV (panel C), 4 DIV (panel D), 6 DIV (panel E) and 10 

DIV (panel F) post addition of HNTs using bright field microscopy at 100x 

magnification. Red arrows indicate association of HNTs with cell spheroid. Scale bar = 

100 µm. 

A summary of the effects each material had on each cell type are shown in Table 

3.1-3.6. 

 

Table 3.1: Effects of CuHARS on primary astrocytes with ~ for no effect, - for small 

effect, and -/- for larger effect. The first three time points applied for both 2D and 3D 

models while the last two time points only applied for 3D model. 

                  Time point 

Concentration 0 div 1 div 4 div 6div (3D) 10 div (3D) 

Low 
~ ~ ~ ~ ~ 

Medium 
~ ~ - - -/- 

High 
~ ~ - - -/- 
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Table 3.2: Effects of CuHARS on brain tumor cells with ~ for no effect, - for small 

effect, and -/- for larger effect. The first three time points applied for both 2D and 3D 

models while the last two time points only applied for 3D model. 

                  Time point 

Concentration 0 div 1 div 4 div 6div (3D) 10 div (3D) 

Low 
~ ~ ~ ~ ~ 

Medium 
~ ~ ~ ~ - 

High 
~ ~ - - -/- 

 

Table 3.3: Effects of CuNPs on primary astrocytes with ~ for no effect, - for small effect, 

-/- for larger effect, and -/-/- for cell death. The first three time points applied for both 2D 

and 3D models while the last two time points only applied for 3D model. 

 
                  Time point 

Concentration 0 div 1 div 4 div 6div (3D) 10 div (3D) 

Low 
~ - - -/- -/- 

Medium 
~ - -/- -/- -/- 

High 
~ -/- -/-/- -/-/- -/-/- 

 

Table 3.4: Effects of CuNPs on brain tumor cells with ~ for no effect, - for small effect, -

/- for larger effect, and -/-/- for cell death. The first three time points applied for both 2D 

and 3D models while the last two time points only applied for 3D model. 

                  Time point 

Concentration 0 div 1 div 4 div 6div (3D) 10 div (3D) 

Low 
~ - - -/- -/- 

Medium 
~ - -/- -/- -/- 

High 
~ -/- -/-/- -/-/- -/- 
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Table 3.5: Effects of HNTs on primary astrocytes with ~ for no effect, - for small effect, 

and -/- for larger effect. The first three time points applied for both 2D and 3D models 

while the last two time points only applied for 3D model. 

 
                  Time point 

Concentration 0 div 1 div 4 div 6div (3D) 10 div (3D) 

Low 
~ ~ - - - 

Medium 
~ - - - - 

High 
~ - -/- -/- -/- 

 

Table 3.6: Effects of HNTs on brain tumor cells with ~ for no effect, - for small effect, 

and -/- for larger effect. The first three time points applied for both 2D and 3D models 

while the last two time points only applied for 3D model. 

 
                  Time point 

Concentration 0 div 1 div 4 div 6div (3D) 10 div (3D) 

Low 
~ ~ ~ ~ ~ 

Medium 
~ ~ ~ ~ ~ 

High 
~ ~ ~ ~ ~ 

 

3.4 Discussion 

Since cells in 2D model grow into a monolayer, changes in cell morphology 

(shape, viability) after interaction with materials happen quicker and can be easily 

measured and quantified. The number of cells and amount of materials required in 2D 

model are also lower compared to 3D model. However, cells in 2D model less accurately 

mimic cell characteristics exhibited in in vivo model, which could lead to incorrect 

response in drug/materials interactions. Moreover, overaggressive cell types (e.g. glioma) 

limit the duration of observation in the 2D model (cell culture becomes confluent over a 

short period of time – Figure 3.6). In contrast, the 3D cell model requires more cells, 

more materials, and more time to grow, but the cells are a more accurate model of cell-
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cell and cell-matrix interaction than the 2D in vivo model. Response to drug/material 

treatment will be closer to in vivo model due to the presence of diffusion barriers 

(multiple cell layers – proliferating, quiescent, necrotic). Cells grow in suspension in 3D 

model also enable longer term experiment (more than 10 DIV). 

Of all three materials tested, CuNPs appeared to be the most toxic to the cells, 

especially to primary astrocytes (Figure 3.9 and Figure 3.27) while CuHARS with the 

same amount of copper showed little to no sign of stress on both primary astrocytes and 

gliomas (Figure 3.3, 3.6, 3,22 and 3.24). Further detailed and quantitative analysis of 

toxicity of these materials on both 2D and 3D models will be presented in Chapter 4. 
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CHAPTER 4 

 

THE USE OF CUHARS AS DELIVERY SYSTEM IN TWO- AND 

 

THREE-DIMENSIONAL CELL MODELS 

4.1 Overview 

CuHARS can be coated with a cancer drug, as a drug delivery system, and it can 

be coated with growth factors to promote cell growth. In this study, CuHARS were 

delivered to both 2D and 3D spheroid models in different concentrations to study the 

effects of the biomaterial to cells (normal and cancer brain cell) over short and long-term 

periods. The results of different bio-physical features will be compared with two other 

materials CuNPs and HNTs as shown in Figure 4.1. 

 

 
Figure 4.1: Schematic diagram of interaction of brain cells with non-degradable and 

degradable materials [9] and their outcome features. 
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We will also study the effect of anti-cancer drugs (cisplatin, paclitaxel and 

disulfiram) as the positive control in 2D and 3D cell models over short and long-term 

periods.   

Interaction of the 3D spheroids with the three materials (CuNPs, CuHARS and 

HNTs) over time is diagrammed in Figure 4.2. As demonstrated in Chapter 3, of three 

materials, CuNPs break down the most rapidly and cause most toxicity to the cell 

initially, but the cells recover over time (especially in case of glioma). HNTs do not break 

down and are taken up/bound by the cells over time. Meanwhile, CuHARS bind to the 

cells and break down over time, causing delayed toxicity to the cells. 

 

 
Figure 4.2: Schematic diagram of 3D spheroid of brain cells after interaction with non-

degradable and degradable materials over time (adapted from [88]). 
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4.2 Materials and Methods 

 Cell Types 

Rat brain glioma cells (CRL-2303) are obtained from American Type Culture 

Collection (ATCC) and cultured in DMEM containing 10% FBS, 1% non-essential 

amino acid solution, and 0.5% penicillin/streptomycin (Appendix A, Section A.1). 

Rat brain astrocytes are harvested from the cortex of newborn rats and cultured in 

astrocyte medium (Ham’s F-12K) containing 10% Horse serum and other components 

(Appendix A, Section A.2).  

 Method  

To test the effects of biomaterials in both 2D and 3D models, cells were grown as 

specified in Chapter 3. Materials were added at day 3 in 2D model and day 7 in 3D 

model at different concentrations. 

After 3 days, MTT assay and DAPI staining were performed to study cell viability 

in 2D model (n =9). For 3D model, microscopic images were recorded using Leica 

DMI600B microscopy every two days and the area of the spheroid was measured using 

Image Pro Plus 7.0 and Matlab 2015b software. Cell viability was measured using a 

resazurin assay with a fluorescent plate reader, at 3,5,7 and 9 DIV, post-treatment (n=4). 

Cancer drugs (cisplatin, paclitaxel, and disulfiram) were added to both models at 

different concentrations to study their effects over short and long-term periods. 

Disulfiram (DSF), an FDA approved drug for alcoholism treatment, has recently been 

studied as a promising drug to treat cancers, including glioblastoma. Moreover, data have 

shown that the effects of DSF is maximized in the presence of copper. Therefore, using a 
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combination of DSF and CuHARS could be a novel approach to treat glioblastoma [15], 

[17]. 

4.2.2.1 Cisplatin 

Cisplatin, a mutagenic and carcinogenic agent [89] that belongs to a class of 

platinum-containing anticancer drugs [90] is used to treat sarcomas, carcinomas, 

lymphomas, testicular cancer, ovarian cancer, cervical cancer, breast cancer, brain tumors 

and neuroblastoma. Cisplatin works by interfering with DNA replication, which means it 

can effectively kill the fastest proliferating cells, i.e. the cancerous cells. It has been 

reported to give enhanced effect for treating glioblastoma by combining with 

temozolomide [91] or conjugated gold nanoparticle [92]. 

4.2.2.2 Paclitaxel 

Paclitaxel is a plant alkaloid that was first isolated from the bark of the Pacific 

yew tree Taxus brevifolia in 1971. It is synthesized in the bark of the tree by endophytic 

fungi. Paclitaxel is a cytoskeletal drug type that binds to tubulin and prevents the 

disassembly of microtubules, subsequently inhibits cell division. It can also induce 

apoptosis by binding to and blocking the function of the apoptosis inhibitor protein Bcl-2 

(B-cell Leukemia 2). Paclitaxel is often used in the treatment of lung, ovarian, breast 

cancer, and pancreatic cancer. A combination of paclitaxel and temozolomide has been 

reported to enhance efficacy in treating malignant glioma [93]. 

 MTT Cell Viability Assay 

MTT (3-(4,5-dimethylthiazol-2-yl)-2,5-diphenyl tetrazolium bromide) obtained 

from Thermo Fisher Scientific (Waltham, MA) was dissolved in 1x DMEM at a 

concentration of 1.25 mg/mL. The MTT solution of 400 L was added to each well and 



66 

incubated for one hour. After one hour, each well was washed and 200 L of 91% 

isopropanol was added and mixed thoroughly (Appendix F). The mix solution was then 

added to a 96 well-plate for spectroscopy. Thermo Scientific Multiskan Spectrum plate 

reader analyzed the wells at a wavelength of 570 nm. Figure 3-4 shows MTT reacting to 

formazan crystals through mitochondrial reductase. 

 

 

Figure 4.3: MTT to formazan crystals in the mitochondria [94]. 

 Resazurin Assay 

Resazurin (7-Hydroxy-3H-phenoxazin-3-one-10-oxide sodium salt) is a dye 

commonly used in cell viability assay [95], [96]. Resazurin by itself is weakly fluorescent 

but is effectively reduced in mitochondria when introduced to cell culture, resulting in a 

strong fluorescent derivative resorufin (Figure 4.4). Resazurin purchased from Sigma 

(#R7017) was diluted in PBS 1x at 0.2mg/ml concentration (Appendix I). Each spheroid 

was moved from original plate to a 96 well-plate with 150 μl media and add 50 μl of 

resazurin solution. The plate was incubated for at least four hours and then analyzed with 

a fluorescence reader Gen5 Biotek Fluorescence Plate Reader at 550 nm, 585 nm 

wavelengths of excitation and emission, respectively. 
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Figure 4.4: Viable cells reduce resazurin to its derivative, highly fluorescent metabolic 

resorufin [95]. 

 Image Analysis 

Image Analysis was carried out using software Image Pro-Plus version 7.0 

developed by Media Cybernetics (Rockville, MD) to measure total area of each material. 

For images stained with DAPI, the total number of nuclei (objects) and total area of 

nuclei were calculated.  

 Statistics 

Data analysis on total area of images cover by each material and cell viability of 

both cell types treated with each material was performed in R software and the 

significance of the test results was analyzed using one-way ANOVA test for normally 

distributed data and Kruskal-Wallis test for non-normally distributed data. The null 

hypotheses were that total area of materials did not change over time and cell viability 

showed no difference between treatment groups. A p-value less than 0.05 was considered 

statistically significant. 
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4.3 Results 

4.3.1 Cell Viability in 2D Model 

4.3.1.1 Interaction with CuNPs 

CuNPs were captured using bright field microscopy and analyzed using Image 

Pro Plus 7.0 software to measure total area. Figure 4.5 shows clearance of CuNPs in 

primary astrocyte (top panel) and glioma (bottom panel) culture in less than 24h for all 

concentrations. As confirmed in Figure 3.7, 3.8 (primary astrocyte) and Figure 3.10, 

3.11 (glioma cells), CuNPs of all concentrations broke down in less than 24h with low 

concentration breaking down as fast as within 3h. 
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Figure 4.5: Total area of CuNPs (0.5µg/ml, 2.5µg/ml and 5µg/ml) added to astrocytes 

and brain tumor cells 2D models over time. n =9 per concentration, error bars represent 

standard deviation. Note the complete breakdown of CuNPs of all concentrations in less 

than 24h. Clearance was concentration-dependent with significant difference denoted by 

** for p≤ 0.01. For astrocyte culture, 2 = 76.166, df = 8, p-value = 2.88e-13. For glioma 

culture, 2 = 77.68, df = 8, p-value = 1.431e-13.  

4.3.1.2 Interaction with CuHARS 

CuHARS were captured using bright field microscopy and analyzed using Image 

Pro Plus 7.0 software to measure total area, as shown in Figure 4.6 and illustrated in 
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Figure 3.1, 3.2 (primary astrocyte) and Figure 3.5, 3.6 (glioma cells), CuHARS were not 

broken down as fast as CuNPs with more than 60% of CuHARS at all concentrations still 

present at 96h time point compared to the 0h time point.  

 

 

 

Figure 4.6: Total area of CuHARS (1µg/ml, 5µg/ml and 10µg/ml) added to astrocytes 

and brain tumor cells 2D models over time. n =9 per concentration, error bars represent 

standard deviation. Note the slow breakdown of CuHARS of all concentrations over time 

compared to CuNPs. Clearance was concentration-dependent with significant difference 

denoted by ** for p≤ 0.01. For astrocyte culture, 2 = 96.903 with df = 11 and p-value = 

7.313e-16. For glioma culture, 2 = 94.92, df = 11, p-value = 1.8e-15.  
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4.3.1.3 Interaction with HNTs 

Fluorescent HNTs were imaged under fluorescent microscopy, and Image Pro 

Plus 7.0 software was used to measure total area. Figure 4.7 shows total area of HNTs in 

primary astrocyte (top panel) and glioma (bottom panel) culture went down over time for 

all concentrations because the materials clumped and were taken up/bound by the cells, 

as illustrated in Figures 3.13 and 3.14 (primary astrocyte) and Figures 3.16 and 3.17 

(glioma cells). 
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Figure 4.7: Total area of fluorescent HNTs (1µg/ml, 5µg/ml and 10µg/ml) added to 

astrocytes and brain tumor cells 2D models over time, n =9 per concentration, error bars 

represent standard deviation. Results were concentration-dependent with significant 

difference denoted by * for p≤ 0.05, ** for p≤ 0.01. For astrocyte culture, 2 = 95.248, df 

= 11, p-value = 1.551e-15. For glioma culture, 2 = 101.01, df = 11, p-value < 2.2e-16. 

The total area of three materials (CuHARS, CuNPs and fluorescent HNTs) over 

time in primary astrocyte and glioma culture are displayed side-by-side in Figures 4.8 

and 4.9. As previously mentioned, CuHARS showed little break down over 4DIV (96h), 
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CuNPs completely broken down in 24h and fluorescent HNTs total area went down as 

HNTs were not broken down but instead taken up/bound by the cells. 

 

 

Figure 4.8: Total area of materials (CuHARS, CuNPs and HNTs) added to astrocytes 2D 

models over time, n =9 per material for each concentration, error bars represent standard 

deviation. Results were concentration-dependent with significant difference denoted by * 

for p≤ 0.05, ** for p≤ 0.01. 2 = 287.63, df = 32, p-value < 2.2e-16. 

 

Figure 4.9: Total area of materials (CuHARS, CuNPs and HNTs) added to glioma 

culture 2D models over time, n =9 per material for each concentration, error bars 

represent standard deviation. Results were concentration-dependent with significant 

difference denoted by ** for p≤ 0.01. 2 = 287.51, df = 32, p-value < 2.2e-16. 
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4.3.1.4 Cell Viability 

 Viability assay results using MTT to measure cell metabolism after interaction 

with materials are shown in Figure 4.10.  Of all three materials, CuNPs were the most 

toxic to the cells, as reflected by the lowest bars, while CuHARS of similar mass 

concentration of copper were less toxic (higher bars). The low concentration of CuHARS 

(1 µg/ml) showed 95% or more cell viability, making it a suitable candidate to use as a 

carrier in delivery system for drug treatment or cell growth. 

 

 

Figure 4.10: Viability assay of CRL-2303 and primary astrocytes in 2D at 4 days after 

addition of CuNPs, CuHARS and HNTs (concentration µg/ml). n =9 per material for 

each concentration, error bars represent standard deviation. The star indicated no toxicity 

in the concentration of CuHARS used. Data was normalized to control. Significant 

difference denoted by ** for p≤ 0.01. 2 = 137.97, df = 17, p-value < 2.2e-16. Viability 

of cells treated with CuHARS was significantly higher than the ones treated with CuNP 

of the same amount of copper. Viability of brain tumor cells treated with HNTs was 

significantly higher than the astrocytes treated with HNTs of the same concentration. 

Cell nuclei area of both cell types after staining with DAPI was measured and 

normalized as illustrated in Figure 4.11. Nuclei area of both cell types treated with 
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CuHARS showed little decrease compared to the control while primary astrocytes treated 

with high concentration of CuNPs demonstrated significant decrease in nuclei area 

compared to the control. 

 

 

Figure 4.11: Nuclei area of primary astrocytes and gliomas 4DIV after treated with 

different materials and stained with DAPI, n =4 per material for each concentration, error 

bars represent standard deviation. Data was normalized to control. Significant difference 

denoted by * for p≤ 0.05, ** for p≤ 0.01. F17,54 = 36.14, p-value < 2e-16. Nuclei area of 

glioma cells were significantly higher than those of primary astrocytes in same treatment 

except for low concentration of CuHARS (1 µg/ml) and CuNPs (0.5 µg/ml).  

 Cell Viability in 3D Model 

An example of high magnification captures of 3D cell spheroid 10 DIV post 

treatment with CuHARS and CuNPs is shown in Figure 4.12. In both cases, the edges of 

the spheroids appeared to be rough with cell debris in media nearby (especially in case of 

the spheroid treated with CuNPs as CuNPs was more toxic than CuHARS). 
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Figure 4.12: Astrocyte spheroid 10 DIV post treatment with CuHARS (25 µg/ml – top 

panel) and CuNPs (12.5 µg/ml – bottom panel). Pictures were taken using phase 

microscopy at 200x magnification. Scale bar = 100 µm. 

4.3.2.1 Interaction with CuNPs 

CuNPs were imaged under bright field microscopy, and Image Pro Plus 7.0 

software was used to measure total area. Figure 4.13 shows clearance of CuNPs in 

primary astrocyte (top panel) and glioma (bottom panel) 3D culture in less than 24h for 
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all concentrations. As confirmed in Figures 3.26 and 3.27 (primary astrocyte) and 

Figures 3.28 and 3.29 (glioma cells), CuNPs of all concentrations broke down in less 

than 24h, with the lowest concentration braking down completely as fast as within 5h. 

 

 

 

Figure 4.13: Total area of CuNPs (2.5µg/ml, 5µg/ml and 12.5µg/ml) added to astrocytes 

and brain tumor cells 3D spheroids. n =4 per concentration, error bars represent standard 

deviation. Note the complete breakdown of CuNPs of all concentrations in less than 24h. 

Clearance was concentration-dependent with significant difference denoted by * for p≤ 

0.05. For astrocyte culture, 2 = 33.014, df = 8, p-value = 6.124e-05. For glioma culture, 

2 = 33.731, df = 8, p-value = 4.544e-05. 
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4.3.2.2 Interaction with CuHARS 

CuHARS were imaged under bright field microscopy, and Image Pro Plus 7.0 

software was used to measure total area. As shown in Figure 4.14 and illustrated in 

Figures 3.22 and 3.23 (primary astrocyte) and Figures 3.24 and 3.25 (glioma cells), 

CuHARS were not broken down as fast as CuNPs with more than 60% of CuHARS at all 

concentrations still present at 96h time point compared to 0h time point. 
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Figure 4.14: Total area of CuHARS (5µg/ml, 10µg/ml and 25µg/ml) added to astrocytes 

and brain tumor cells 3D models, n =4 per concentration, error bars represent standard 

deviation. Clearance was concentration-dependent with significant difference denoted by 

* for p≤ 0.05. For astrocyte culture, 2 = 56.466, df = 14, p-value = 4.84e-07. For glioma 

culture, 2 = 57.803, df = 14, p-value = 2.838e-07. 

4.3.2.3 Interaction with HNTs 

Fluorescent HNTs were imaged under fluorescent microscopy, and Image Pro 

Plus 7.0 software was used to measure total area. Figure 4.15 shows total area of HNTs 
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previously illustrated in Figure 3.30, 3.31 (primary astrocyte) and Figure 3.32, 3.33 

(glioma cells). 

 

 

 

Figure 4.15: Total area of fluorescent HNTs (5µg/ml, 10µg/ml and 25µg/ml) added to 

astrocytes and brain tumor cells 3D models, n =4 per concentration, error bars represent 

standard deviation. Results were concentration-dependent with significant difference 

denoted by * for p≤ 0.05. For astrocyte culture, 2 = 51.944, df = 14, p-value = 2.874e-

06. For glioma culture, 2 = 54.823, df = 14, p-value = 9.286e-07.  

Results of the Resaruzin assay to measure glioma cell spheroid metabolism after 
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the quickest to cause stress on the cell spheroid reflected by the lowest bars but glioma 

spheroids show sign of recurrence as the viability went up at later time point (indicated 

by the dashed arrow went up) while CuHARS of the similar concentration of copper 

illustrated a delay effect (indicated by the dashed arrow went down) as glioma spheroids 

at later time point were more stressed than the ones at earlier time point (the viability 

decreased over time). That delay effect occurs because CuHARS breaks down over time 

under physiological conditions, releasing the copper and causing stress to the cell 

spheroid, another demonstration makes it a suitable candidate to use as a carrier in 

delivery system for drug treatment. HNTs, meanwhile showed little to no toxicity on the 

spheroids at all concentrations. 

 

 

Figure 4.16: Viability assay of CRL-2303 spheroid added with CuNPs, Cu-HARS and 

HNTs over 3,5,7 and 9 days, n =4 per material for each concentration, error bars 

represent standard deviation. Data was normalized to control. Significant difference 

denoted by * for p≤ 0.05 with 2 = 77.405, df = 35, p-value = 4.848e-05. 
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Resaruzin assays were also carried out to measure primary astrocyte cell spheroid 

metabolism after interaction with materials are shown in Figure 4.17. High concentration 

of CuNPs (25µg/ml) were significantly more toxic to the astrocyte spheroid compared to 

the CuHARS with same concentration of copper. 

 

 

Figure 4.17: Viability assay of primary astrocyte spheroid added with CuNPs, Cu-HARS 

and HNTs over 3,5,7 and 9 days, n =3 per material for each concentration, error bars 

represent standard deviation. Data was normalized to control. Significant difference 

denoted by ** for p≤ 0.01 with 2 = 66.914, df = 35, p-value = 0.0009246. 

 Cell Viability in Brain Tumor Cells Treated with Cancer Drug 

4.3.3.1 CRL-2303 Spheroids Treated with Cancer Drugs Cisplatin and Paclitaxel 

Results from the Resaruzin assay to measure glioma cell spheroid metabolism 

after interaction with cancer drugs cisplatin and paclitaxel are shown in Figure 4.18. 
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reduction in cell viability from day 3 to day 9 in vitro occurred due to the aggressiveness 

of glioma. 

 

 

Figure 4.18: Viability assay of CRL-2303 spheroid added with cisplatin, and paclitaxel 

over 3,5,7 and 9 days (concentration µg/ml), n =4 per drug for each concentration, error 

bars represent standard deviation. Data was normalized to control. 2 = 31.57, df = 23, p-

value = 0.1094. There was no significant difference in cell viability between treatment 

groups. 

4.3.3.2 CRL-2303 Treated with Disulfiram. 

Viability of glioma cells treated with DSF in both 2D and 3D models was 

investigated and illustrated in Figures 4.19 and 4.20. In the 2D cell culture model 

(Figure 4.19), DSF was effective in killing glioma cell as a DSF concentration of 300nM 

shows 40% reduce in cell metabolism and increases to 65% at 500nM concentration of 

DSF. However, the effect of DSF was significantly decreased in 3D model, as shown in 

Figure 4.20 as a DSF concentration of 50µM displays only 20% decrease in cell 

metabolism 6 DIV post treatment. 
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Figure 4.19: MTT assay of 2D model of CRL-2303 (10k cells/well) treated with 

different concentration of DSF after 24h, n =3 per concentration, error bars represent 

standard deviation. Data was normalized to control. Significant difference from control 

denoted by * for p≤ 0.05, ** for p≤ 0.01. 2 = 19.013, df = 5, p-value = 0.004142. There 

was a significant decrease in cell viability of glioma cells treated with 200, 300, 400 and 

500 nM concentrations of DSF compared to control. 
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Figure 4.20: Viability assay of CRL-2303 spheroid treated with CuNPs and different 

concentrations of DSF after 3 and 6 days. n =3 per material for each concentration, error 

bars represent standard deviation. Much higher concentrations of DSF (50, 100 µM) 

compared to 2D model were used due to the larger number of cells (200k cells vs. 30k 

cells in 2D model). Data was normalized to control. Significant difference denoted by * 

for p≤ 0.05, ** for p≤ 0.01. 2 = 19.117, df = 5, p-value = 0.003971. There was a 

significant decrease in cell viability of spheroids treated with CuNPs on both time points 

and spheroids treated with DSF of both concentrations on day 6 compared to control.  

Viability of glioma cells treated with the combination of DSF and CuHARS in 2D 

model was investigated and shown in Figures 4.21 and 4.22. As displayed in Figure 

4.21, the combination of DSF and CuHARS (panel B) was more effective than DSF alone 

in killing glioma cells, as indicated by more round cells (Figure 4.21 –panel B & C) and 

MTT result (Figure 4.22). The combination of DSF and CuHARS caused significantly 

more toxicity to brain tumor cells than DSF alone (40 & 80% compared to 16% decrease 

in cell metabolism). 
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Figure 4.21: Interaction of CRL-2303 with the combination of CuHARS and DSF. Cells 

were plated at 10k cells/well. CuHARS were added 1 day while DSF was added 4 days 

after cells attached. Pictures were taken 24h post DSF addition: control (panel A), 5µg/ml 

CuHARS and 250nM DSF (panel B) and 250nM DSF (panel C) at 200x magnification. 

Scale bar = 100 µm. 

 

Figure 4.22: Viability assay of 2D model of CRL-2303 24h post treatment of DSF 

combined with CuHARS. Cells were plated at 10k cells/well. CuHARS were added 1 and 

3 days while DSF was added 4 days after cells attached. Data were normalized to control 

plus standard deviation, n = 3 per material for each concentration. Significant difference 

from control denoted by * for p≤ 0.05, ** for p≤ 0.01. 2 = 13.5, df = 4, p-value = 

0.009074. There was a significant decrease in cell viability of gliomas treated with 

combinations of CuHARS and DSF compared to control and the ones treated with 

CuHARS and DSF alone. 
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involved in the metabolism of alcohol), and has shown great potential in targeting cancer 

cell [17], [97]. 

Although the anticancer mechanisms of DSF are still not fully understood, studies 

have indicated that DSF chelates bivalent metals such as copper (Cu) and zinc (Zn) to 

form DSF metal complexes that inhibit proteasome activity and block the degradation of 

IκB and NFκB nuclear translocation [97]. In other words, the presence of copper 

increases the effect of DSF. 

As the data show in this study, a combination of novel copper-contained 

biomaterial CuHARS with DSF showed significant increase in cancer cell death 

compared to DSF alone. This study can be used as a foundation for a therapeutic 

approach for effective cancer treatment by incorporating DSF into CuHARS for targeted 

drug delivery. 

Figure 4.23 shows the interaction of DSF and CuHARS in sterile water. As 

mentioned above, DSF could form metal complex with copper, such as that in CuHARS.  

The combination of both DSF and CuHARS led to new structures (blue arrows) that did 

not appear when both materials were put separately in sterile water. 
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Figure 4.23: Combination of DSF and sonicated CuHARS in water. Pictures were taken 

using bright field microscope at 630x magnification. Scale bar = 20 µm. 

The same viability study with combination of DSF and CuHARS was also carried 

out in 3D model (Figure 4.24). All combinations of DSF and CuHARS showed much 

improvement in suppressing glioma viability as cell metabolism reduced to 25%-43%, 

compared to 95% with DSF alone. 
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Figure 4.24: Viability assay of CRL-2303 spheroid treated with combination of DSF and 

non-sonicated and sonicated CuHARS 7 DIV post treatment, n =3 per material for each 

concentration, error bars represent standard deviation. Data was normalized to control. 

Significant difference from control denoted by ** for p≤ 0.01. 2 = 14.52, df = 5, p-value 

= 0.01262. There was a significant decrease in cell viability of glioma spheroids treated 

with combinations of CuHARS and DSF compared to control and the ones treated with 

DSF alone. 

4.4 Discussion 

Of all three materials, CuNPs degraded fastest in both 2D and 3D models. CuNPs 

broke down completely in 3-5h at low concentrations and in less than 24h at all 

concentrations (Figures 4.5 and 4.13). CuNPs also caused most toxicity to the cells in 2D 

model (lowest cell viability – Figure 4.10) and initially in 3D model at high 

concentrations (Figures 4.16 and 4.17) but the cell recovered over time, especially in the 

case of gliomas (cell viability went up over time). On the other hand, CuHARS showed 

low stress on the cells in 2D model and initially in 3D model, but as the material broke 

down over time, cell viability decreased, indicating a delay effect on both cell types. 

Moreover, the combination of CuHARS and DSF to form DSF metal complex showed 

significantly increase in growth inhibition of gliomas in both 2D and 3D models (Figures 
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4.22 and 4.24) suggesting a promising approach in treating gliomas that needed further 

investigation. 
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CHAPTER 5 

 

MODIFICATION OF THE CUHARS 

5.1 Overview 

As previously discussed, CuHARS has the potential to be used as a delivery 

system for drug treatment or cell growth promotion as well as in combination with other 

chemicals/drugs for cancer treatment (DSF). One of the challenges with the current 

synthesized CuHARS is the large variability in size of the material.  Some CuHARS can 

have the length of up to 200 µm or more, making them too long for the cells to uptake 

and also taking longer time to break down. The goal of this chapter is to introduce a 

simple method to modify the CuHARS to get a more uniform size and shape for better 

carrier and interaction with cells. 

5.2 Materials and Methods 

 Materials 

CuHARS after synthesis as described [9]–[11], [14] at concentration of 2mg/ml. 

Microcentrifuge tubes 0.65 ml (VWR, 87003-290) for sonicating CuHARS. 

 Cell Types 

Rat brain astrocytes are harvested from the cortex of newborn rats and cultured in 

astrocyte medium (Ham’s F-12K) containing 10% horse serum and other components 

(Appendix A, Section A.2). The cells were plated in a cell culture 48 wells plate at the 
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density of 20,000 cells/mL and grown in an incubator with 5% CO2 and at 37°C for 5 

DIV before adding the materials. 

 Sonication 

CuHARS was added to 0.65 ml plastic vial at the concentration of 1 mg/ml and 

total volume is 400 µL. The vial was then sonicated in Branson 1510 Ultrasonic Cleaner 

for 20 minutes. During the sonication process, CuHARS were checked to ensure that they 

did not settle down to the bottom of the vial. 

 Image Analysis 

Image Pro-Plus software version 7.0 developed by Media Cybernetics (Rockville, 

MD) was used to measure length and area of the CuHARS. 

 Statistics 

Data analysis was performed in R software and the significance of the test results 

was analyzed using Kruskal-Wallis test to evaluate the hypothesis that the length and area 

of the CuHARS before and after sonication were significantly different. The null 

hypothesis was that the length and area of the CuHARS did not change after sonication. 

A p-value less than 0.05 was considered statistically significant. 

5.3 Results 

 Comparison of CuHARS before and after Sonication 

CuHARS before and after sonication is shown in Figure 5.1. On the left panel, 

the non-sonicated CuHARS displayed varieties in length with some reaching lengths up 

to 80µm while the sonicated CuHARS on the right panel demonstrated a much more 

uniform length. 
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Figure 5.1: CuHARS before (left panel) and after (right panel) sonication. CuHARS 

were diluted to a final concentration of 10 µg/ml in sterile water. Pictures were taken 

using bright field microscope at 200x magnification. Scale bar = 100 µm. 

High magnification picture of Figure 5.1 right panel is shown in Figure 5.2. The 

sonicated CuHARS appeared to retain properties in sterile water with no big clumps as 

the material carries a negative charge [14]. 

 

 

Figure 5.2: CuHARS after sonication. CuHARS were diluted to a final concentration of 

10 µg/ml in sterile water. Pictures were taken using bright field microscope at 400x 

magnification. Scale bar = 100 µm. 
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Figure 5.3 compares the population and total area of the CuHARS before and 

after sonication. Even though the breakdown of longer CuHARS to shorter ones caused 

the number of sonicated CuHARS to increase 3-fold compared to the non-sonicated 

CuHARS, the total area of sonicated CuHARS shows no significant increase/decrease 

compared to non-sonicated CuHARS indicating no material was lost during the 

sonication process. 
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Figure 5.3: Comparison in number (top graph) and total area (bottom graph) of CuHARS 

before and after sonication. Results were concentration-dependent with significant 

difference denoted by * for p≤ 0.05, ** for p≤ 0.01. For number of CuHARS before and 

after sonication, 2 = 28.232, df = 5, p-value = 3.279e-05. For total area of CuHARS 

before and after sonication, 2 = 26.13, df = 5, p-value = 8.419e-05. 

The CuHARS area before and after sonication is presented in Figure 5.4. The 

majority of sonicated CuHARS have an area within the range of 2-8 µm2 (66.9%), and 

only 4.3% of CuHARS have area equal or larger than 24 µm2 (4.3%).  Most (61.6%) of 

the non-sonicated CuHARS had an area between 2-14 µm2, but many had area equal or 

greater than 24 µm2 (22.1%). 
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Figure 5.4: Histogram comparison in size (µm2) of CuHARS before (top graph) and after 

(bottom graph) sonication. 

The CuHARS length distributions are shown in Figure 5.5. Most (93.2%) of 

sonicated CuHARS have a length within the range of 2-8 µm, and almost none have 

length equal or larger than 10 µm (4.3%).  The length of most non-sonicated CuHARS, 

(62.2%) varies from 2-11 µm, but 21% have length equal to or greater than 17 µm. 
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Figure 5.5: Histogram comparison in length (µm) of CuHARS before (top graph) and 

after (bottom graph) sonication. 

 

 Comparison of CuHARS before and after Sonication in Cell Culture 

Clearance of non-sonicated and sonicated CuHARS in primary astrocyte culture 

over time is displayed in Figures 5.6 and 5.7. While most of the sonicated CuHARS 

broke down after 6 DIV and completely disappeared in 16 DIV (Figure 5.7 panel D2, 

F2), many non-sonicated CuHARS were still present in the culture after 16 DIV (Figure 
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5.6 panel F2). Moreover, the reduced, uniform size of the sonicated CuHARS, which 

helped the cells bind/uptake the material easier, makes them better carriers for drug 

delivery compared to the non-sonicated CuHARS. 
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Figure 5.6: Interaction of non-sonicated CuHARS (1 µg/ml concentration) with primary 

astrocytes. Cells were plated at 20k cells/well and CuHARS were added 5 days after cells 

attached. Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1, D1, E1, 

F1 were taken using phase microscopy, pictures A2, B2, C2, D2, E2, F2 were taken using 

bright field microscopy. Pictures were taken at 0h (panel A), 24 (panel B), 48h (panel C), 

6div (panel D), 12 div (panel E) and 16 div (panel F) post addition at 200x magnification. 

Red arrows indicate CuHARS. Scale bar = 100µm. 
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Figure 5.7: Interaction of sonicated CuHARS (1 µg/ml concentration) with primary 

astrocytes. Cells were plated at 20k cells/well and CuHARS were added 5 days after cells 

attached. Panels 1 and 2 were taken of the same areas with pictures A1, B1, C1, D1, E1, 

F1 were taken using phase microscopy, pictures A2, B2, C2, D2, E2, F2 were taken using 

bright field microscopy. Pictures were taken at 0h (panel A), 24 (panel B), 48h (panel C), 

6div (panel D), 12 div (panel E) and 16 div (panel F) post addition at 200x magnification. 

Red arrows indicate CuHARS. Scale bar = 100µm. 

Analysis of both non-sonicated and sonicated CuHARS clearance over time is 

shown in Figure 5.8, which confirms the complete breakdown of sonicated CuHARS 
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after 16 DIV for all concentrations, compared to the presence of the non-sonicated 

CuHARS after 16 DIV even at low concentration (1µg/ml). 

 

 

 

Figure 5.8: Total area of CuHARS (1µg/ml, 5µg/ml and 10µg/ml) in primary astrocytes 

culture over time. n =3 for each concentration, error bars represent standard deviation. 

Results were concentration-dependent with significant difference denoted by ** for p≤ 

0.01. For the CuHARS before sonication, 2 = 84.622, df = 23, p-value = 5.579e-09. For 

the CuHARS after sonication, 2 = 99.914, df = 23, p-value = 1.457e-11. All 

concentrations of non-sonicated CuHARS showed no significant decrease in terms of 

total area at 16div time point compared to 0h time point while medium and high 

concentrations of sonicated CuHARS showed significant decrease in terms of total area at 

16div time point compared to 0h time point.  
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5.4 Discussion 

CuHARS after sonication displayed a much more uniform size and length 

compared to the ones before modification, with the majority of CuHARS having lengths 

of less than 7 µm in contrast to the non-sonicated CuHARS which had numerous 

examples with length of 35 µm or longer. Moreover, characteristics of the material 

appeared to be unchanged after modification. The smaller size of sonicated CuHARS 

helped to increase the chances for the material being taken up by or bound to the cells, 

and it accelerated the degradation of the materials (Figure 5.7 and Figure 5.8) which in 

turn made the sonicated CuHARS a promising candidate to be used as a delivery system.  
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CHAPTER 6 

 

CO-CULTURE MODELS OF PRIMARY ASTROCYTES AND 

 

GLIOMAS TO STUDY CANCER MICROENVIRONMENT  

6.1 Overview 

Since the brain and almost all other organs consist of not one but many different 

cell types, co-culture models (both 2D and 3D) are important tools to investigate cell-cell 

interaction in addition to cell response to drugs and other materials [98]. The goal of this 

chapter is to demonstrate cell interaction in a traditional 2D model and to use our novel 

matrix free technique of making 3D spheroid in building models of co-culture of both 

normal brain cells and glioblastoma. This will allow us to better understand cell behavior 

in different environments before performing to in vivo studies. 

6.2 Materials and Methods 

6.2.1 Cell Types 

Rat brain glioma cells CRL-2303 (C6/lacZ7) were obtained from American Type 

Culture Collection (ATCC) and cultured in DMEM containing 10% FBS and other 

components (Appendix A, Section A.1). 

Rat brain astrocytes are harvested from the cortex of newborn rats and cultured in 

astrocyte medium (Ham’s F-12K) containing 10% horse serum and other components 

(Appendix A, Section A.2).   
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6.2.2 Methods 

For the 2D co-culture experimental model, glioma cells (CRL-2303) and normal 

brain astrocytes were placed at the ratio 1:3 in their respective growth media into the 

same well in a 48-well cell culture plate (Griener) and allowed to grow in an incubator 

with 5% CO2 and 37°C for 3 days. 

For the 3D co-culture experimental model, glioblastoma and primary astrocytes 

were placed at different ratios in their respective growth media into the same well in a 48-

well suspension plate to form a spheroid using the Matrix-free system (Nanogaia #SSD-

01, Ruston, LA - http://www.nanogaia.com/) and allowed to grow for 5 DIV before 

staining.   

6.2.3 Cell Fixation 

After 3 days in vitro, the growth medium from the cells was aspirated and washed 

twice with 500 µL 1X PBS. Cells were fixed in the fixation solution from β-gal kit 

(Appendix H, Section H.1 and H.2) such that it covers the entire well, and the plate was 

kept at room temperature for 10 minutes. The cells were rinsed twice with 500 uL 1X 

PBS again. 

6.2.4 GFAP Staining 

To confirm normal in vitro characteristics, cells were stained using indirect 

immunofluorescence for glial fibrillary acidic protein (GFAP), a cytoskeletal protein 

found specifically in glial cells. Cells were stained using Anti-Glial Fibrillary Acidic 

Protein (Anti-GFAP), antibody produced in rabbit as 1° Ab from Sigma-Aldrich (Sigma 

Product #G9269), and Alexa Fluo® 488 goat anti-rabbit IgG (H+L) as 2° Ab from 

Invitrogen Molecular Probes (Invitrogen Product #A-11035) (Appendix G). 

http://www.nanogaia.com/
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6.2.5 β-galactosidase Staining 

As the GFAP stained both astrocytes and glioma cells, CRL-2303 cells were 

counterstained with β-gal staining to distinguish between the cell types in a co-culture 

experimental model (Appendix H, Section H.3). A β-galactosidase Reporter Gene 

Staining Kit was obtained from Sigma-Aldrich (Sigma Product #GALS).  

6.2.6 Image Analysis 

Image Pro-Plus software version 7.0 developed by Media Cybernetics (Rockville, 

MD) was used to determine the total area covered by normal brain astrocytes and glioma 

cells from the GFAP and β-gal staining in each image.  

6.3 Results 

6.3.1 2D Co-Culture of Glioma and Primary Astrocytes  

Co-culture of glioma and astrocytes stained with GFAP is shown in Figure 6.1. 

Both glioma and primary astrocytes stained positive for GFAP because glioma cells were 

derived from the astrocytes [41], [42], [99]–[101]. 
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Figure 6.1: GFAP staining for co-culture of 4,000 glioma and 12,000 primary astrocytes 

cells per ml. Panel A and C represent phase image of the cells before and GFAP staining 

while panel B (with 1° Ab) and D (without 1° Ab) represent fluorescence images of 

respective area after GFAP staining. Scale bar = 100 µm. 

Since GFAP stains both glioma and astrocyte cells, β-galactosidase staining was 

used in addition to GFAP to visualize the glioma cells in co-culture environment. Figure 

6.2 shows co-culture of normal brain astrocytes and glioma cells stained with both GFAP 

and β-galactosidase. Both normal brain astrocytes and glioma cells (Figure 6.2 panel A2) 

stained positive for GFAP staining in positive controls (1° Ab + 2° Ab) while negative 

controls (no 1° Ab) (Figure 6.2 panel B2) did not show staining. β-galactosidase stained 

the glioma cells but not the normal brain astrocytes an indigo blue color in a co-culture 

model. Figure 6.2, panels A3 and B3, show positive β-galactosidase staining of gliomas. 
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Figure 6.2: GFAP and β-galactosidase staining for co-culture of 4,000 cells/ml gliomas 

(CRL-2303) and 12,000 cells/ml normal brain astrocytes. Panel A1, B1 (after GFAP 

staining) and A3, B3 (after β-galactosidase staining) were taken using phase microscopy 

whereas panel A2 and B2 were taken with fluorescent microscopy (after GFAP staining). 

Scale bar = 100 µm.   

6.3.2 3D Co-Culture of Glioma and Primary Astrocytes Spheroid 

Glioma spheroid stained with β-galactosidase is shown in Figure 6.3. All the cells 

were stained with indigo blue color while a co-culture spheroid of glioma and astrocytes 

(Figure 6.4) displays areas of unstained cells, indicating the primary astrocytes. Both cell 

types did not spread out evenly, instead the glioma demonstrated tumorous behavior by 

growing into patches.      
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Figure 6.3: Three-dimensional spheroid of glioblastoma stained with β-galactosidase. 

Scale bar = 100 µm. 

 
Figure 6.4: Co-culture spheroid of glioblastoma and primary astrocyte at the ratio of 1 to 

3 stained with β-galactosidase after 4DIV. Scale bar = 400 µm.  

As mentioned above, GFAP stains both glioma and primary astrocytes.  However, 

β-galactosidase as a colorimetric assay quenches the fluorescence of the GFAP. 

Therefore, a co-culture spheroid of glioblastoma and primary astrocyte stained first with 

β-galactosidase and secondly with GFAP can still present the two cell types under 



109 

fluorescent microscopy, as shown in Figure 6.5, with the astrocytes turned green due to 

GFAP while the glioma remained dark blue due to β-galactosidase staining. 

 

 

Figure 6.5: Co-culture spheroid of glioblastoma and primary astrocyte at the ratio of 1 to 

1 4DIV stained with GFAP. Scale bar = 100 µm. 

Co-culture spheroid models with different ratios of brain tumor vs. astrocytes 

cells were investigated as shown in Figure 6.6. Spheroids were stained with β-

galactosidase and analyzed using Image Pro Plus 7.0 software to study tumor invasion in 

co-culture.  
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Figure 6.6: Co-culture spheroid with different ratio of brain tumor vs. astrocytes cells (1 

to 1, 1 to 2, 1 to 3 and 1 to 4, respectively) stained with β-galactosidase. Pictures were 

taken 5 DIV after placing the cells into culture conditions. Scale bar = 100 µm. 

Total area coverage by β-gal staining of co-culture spheroid models, which is an 

indication of glioma cells is shown in Figure 6.7.  
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Figure 6.7: Percentage of brain tumor cells in co-culture spheroid with different ratios of 

normal brain cells astrocytes and brain tumor cells, 1 to 1, 1 to 2, 1 to 3 and 1 to 4, 

respectively. n =4 for each ratio, error bars represent standard deviation. Significant 

difference denoted by * for p≤ 0.05. F3,12 = 11.21, p-value = 0.000855.  

6.4 Discussion 

We successfully demonstrated integration of two different cell types into a co-

culture environment at both 2D and 3D models with different ratios of gliomas and 

primary astrocytes. Due to their aggressive growth rate, glioma cells could invade and 

take over the culture in a short amount of time in 2D model. Therefore, a 3D co-culture 

spheroid may be a better model for long term investigation of role of cell–cell physical 

contact, autocrine and paracrine effects on cell functions as well as cell differentiation 

[102], [103].  Co-culture spheroids with different ratios of glioma and primary astrocytes 

could be used to study different stages of tumorigenesis [104] as well as interaction with 

materials (e.g. combination of CuHARS and DSF). Moreover, the same method could be 

used to pair up various cell types (endothelial together with gliomas to study the 

influence of brain tumor on blood brain barrier [105], [106]) or integration of three or 

more cell types [107]. 
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CHAPTER 7 

 

CONCLUSIONS 

Both two- and three-dimensional cell culture models are used for in vitro 

research, with traditional 2D cell culture used more frequently in cell assay and drug 

discovery. However, 3D cell spheroid has emerged in recent years to close the gap 

between in vitro and in vivo cell models. Each model has its own advantages and 

disadvantages. Traditional 2D cell culture is a convenient, inexpensive, and quick way to 

study drug testing but may not provide accurate responses due to cell morphology and 

cell-cell interaction which are different from in vivo. Also, duration of 2D cell models 

varies and depends on cell types but in most cases does not expand longer than 7 days 

with majority only last 3 to 5 days. On the other hand, 3D cell models grow cells into 

aggregates/spheroids with different layers of cells (proliferating layer, quiescent layer and 

necrotic core) which better resemble 3D environment of the cells in tissue. Moreover, 3D 

cell models can last up to a month in vitro making them more suitable for long-term 

studies. However, 3D models require longer preparation time, larger numbers of cells, 

and more drugs/chemicals. Analyzing 3D spheroid data also proves to be challenging.  

In this dissertation, we validated the similarity and difference between 2D and 3D 

cell models in terms of cell morphology as well as their interactions with various 

materials. The results demonstrated that while there were similarities in the ways cells 

interact and respond to materials and drugs, 2D models were more suitable in situations 
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where fast screening for materials/drugs response was desired or for preliminary 

experiments, whereas 3D models better fit situations where long-term cell-cell and cell-

materials interactions were the focus, especially in cases of cancerous cells which had 

distinctive feature of aggressive proliferation. Furthermore, we demonstrated the ability 

to grow different cell types (normal astrocytes and glioma) in a co-culture environment to 

more accurately mimic the brain tumor microenvironment. 

 

 

Figure 7.1: Schematic diagram comparing two-and three-dimensional cell models 

(adapted from [88]). 

The novel material CuHARS developed by our group which is made from copper 

and the amino acid cystine has promising potential to be used as a carrier in a delivery 

system because it has many unique characteristics, including biodegradable behaviors in 

body physiological conditions, less toxicity to the cells compared to copper at the same 

concentration, and enhanced suppression of glioma when used in combination with DSF 

exploiting the very low aggregation property of the CuHARS. Moreover, we established 
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a method to modify the CuHARS to get a more uniform size and shape of material for 

better carrier properties and interaction with cells. Future studies include coating the 

CuHARS with various cancer drugs and growth factors (we have had some preliminary 

results in the lab with fluorescent bead labeled CuHARS) and testing these materials in 

co-culture systems. 
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APPENDIX A  
 

  CELL CULTURE MEDIA 

A.1 CRL-2303 Media 

A.1.1 Materials Required for 250 mL Media  

• Sterile filtration unit 

• 221.25 mL Dulbecco’s Modified Eagle’s Medium (DMEM) 

• 25 mL Fetal Bovine Serum (FBS) (10 %) 

• 2.5 mL Amino acid solution (1 %) 

• 1.25 mL Penicillin/Streptomycin solution (P/S) (0.5 %) 

A.1.2 Preparation of CRL-2303 Growth Media  

The procedure is carried out in a laminar flow hood (sterile environment). 

1. Add 110.25 mL DMEM to sterile filtration unit. 

2. Add Fetal Bovine Serum, Amino acid solution, and P/S to sterile filtration unit. 

3. Add 111 mL DMEM to sterile filtration unit. 

4. Place the lid over sterile filtration unit and connect it to vacuum nozzle. 

5. Carefully turn on the vacuum and allow the liquid to pass through the filter. Make 

sure to hold sterile filtration unit during this step so the unit does not turn over. 

Turn off the vacuum before bubbles form. 

6. Twist top of filtration unit off carefully. Screw sterile cap onto container of 

media. 



116 

7. Label media as CRL-2303 media with date and your initials, and store in 

refrigerator. 

A.2 Astrocyte Media 

A.2.1  Materials Required for 250 mL Media 

• Sterile filtration unit 

• 223.75 mL Ham’s F-12K media with L-Glutamine 

• 12.5 mL Fetal Bovine Serum (FBS) (5.0 %) 

• 12.5 mL Horse Serum (5.0 %) 

• 1.25 mL Penicillin/Streptomycin solution (P/S) (0.5 %) 

 

A.2.2 Preparation of Astrocyte Growth Media  

The procedure is carried out in a laminar flow hood (sterile environment). 

1. Add 100 mL Ham’s F-12K media to sterile filtration unit. 

2. Add Fetal Bovine Serum, Horse Serum, and P/S to sterile filtration unit. 

3. Add 123.75 mL Ham’s F-12K media to sterile filtration unit. 

4. Place the lid over sterile filtration unit and connect it to vacuum nozzle. 

5. Carefully turn on the vacuum and allow the liquid to pass through the filter. Make 

sure to hold sterile filtration unit during this step so the unit does not turn over. 

Turn off the vacuum before bubbles form. 

6. Twist top of filtration unit off carefully. Screw sterile cap onto container of 

media. 

7. Label media as Astrocyte media with date and your initials, and store in 

refrigerator. 
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A.3 Locke’s Solution 

A.3.1 Materials Required for 250 mL Media 

• 2250 mg of Sodium Chloride (NaCl) (154 mM) 

• 104.4 mg of Potassium Chloride (Kcl) (5.6 mM) 

• 75.6 mg of Sodium Bicarbonate (NaHCO3) (3.6 mM) 

• 84.5 mg of Calcium Chloride (Cacl2.2H2O) (2.3 mM) 

• 252.3 mg of Glucose (5.6 mM) 

• 1.25 ml of 1M stock 4-(2-hydroxyethyle)-2-piperazineethanesulfonic acid 

(HEPES) (pH 7.4) (5 mM) 

• 248.75 mL purified water 

A.3.2 Preparation of Locke’s Solution 

1. Dissolve the components in 100 ml of purified water and add to the vacuum 

filtration unit. 

2. Add 100 ml of purified water to vacuum filtration unit. 

3. Add water with dissolved components. 

4. Add 1.25 ml of 1 M stock HEPES. 

5. Add remaining amount of purified water. 

6. Place cap on unit. Carefully turn on the vacuum. 

7. Allow all the liquid to pass through the filter. Turn off the vacuum before bubbles 

form. 

8. Twist the top of vacuum unit off carefully. Screw the sterile cap onto the container 

of the solution. 

9. Label as Locke’s solution with date and your initials, and store in refrigerator. 
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APPENDIX B  
 

SPLITTING AND FREEZING CELLS 

B.1 Splitting Cells or Re-Plating Cells  

1. Remove media from cells into a waste beaker.  

2. Wash flask once with 3 ml of 1X PBS (1 mL 10X PBS + 9 mL sterile water gives 

10 mL 1X PBS). Pipet PBS gently into a flask. Lay flask down once. Lift flask 

and remove PBS. 

3. Add 1.5 mL (for CRL-2303 and Microglia) or 3 mL (for Astrocytes) thawed 

trypsin/EDTA to flask. Cap the flask and put it in the incubator for 3 minutes (for 

CRL-2303 and Microglia) or 8 minutes (for Astrocytes). Take the flask out of the 

incubator and check under microscope to ensure cells are detached. 

4. Add 3 mL fresh media to the flask and transfer them to a 15 mL centrifuge tube.  

5. Centrifuge cells in a tube using a counterbalance in pre-cooled centrifuge (8°C) at 

160 r.c.f. (relative centrifugal force) for 8 minutes. 

6. After spinning, remove the supernatant liquid into waste beaker. 

7. Suspend pellet in desired amount of media, then vortex until cells are evenly 

distributed throughout media. 

8. Before plating, count the number of cells using a hemocytometer. 

9. Plate cells onto the flask, adding the appropriate amounts of media. 
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10. Label flask with cell name, date, and passage number (passage number increases 

after splitting cells).

B.2 Freezing Cells 

1. Remove media from cells into a waste beaker.  

2. Wash flask once with 3 mL of 1X PBS (1 mL 10X PBS + 9 mL sterile water 

gives 10 mL 1X PBS). Pipet PBS gently into a flask. Lay flask down once. Lift 

flask and remove PBS. 

3. Add 1.5 mL (for CRL-2303 and Microglia) or 3 mL (for Astrocytes) thawed 

trypsin/EDTA to flask. Cap the flask and put it in the incubator for 3 minutes (for 

CRL-2303 and Microglia) or 8 minutes (for Astrocytes). Take the flask out of the 

incubator and check under microscope to ensure cells are detached. 

4. Add 3 mL fresh media to the flask and transfer them to a 15 mL centrifuge tube.  

5. Centrifuge cells in a tube using a counterbalance in pre-cooled centrifuge (8°C) at 

160 r.c.f. (relative centrifugal force) for 8 minutes. 

6. After spinning, remove the supernatant liquid into waste beaker. 

7. Suspend pellet in desired amount of media, then vortex until cells are evenly 

distributed throughout media. 

8. Add 5% DMSO dropwise to cells. Mix by inverting centrifuge tube. 

9. Transfer cell mixture to pre-cooled cryovial.  

10.  Label cryovial with cell name, date, and passage number (passage number is 

same as on the flask). 

11.  Put cryovials in a container and place in -80°C freezer overnight. 

12.  Transfer cells into liquid nitrogen. Record the cane number. 
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APPENDIX C  
 

THAWING AND FEEDING CELLS

C.1 Thawing Cells  

1. Remove vial of cells from liquid nitrogen and immediately place in water bath 

preheated to 37°C.  

2. Thaw the vial containing cells quickly (approximately three minutes). 

3. Remove the vial, wipe the vial with kim wipe and isopropanol under the laminar 

flow hood. 

4. Mix cell suspension by pipetting up and down the vial. Do not vortex cells. 

5. Gently transfer the cell suspension from the vial into a flask with 5 mL pre-

warmed cell growth media.   

6. Label flask with cell type, date, and passage number (passage number increases 

when thawing cells). 

7. Incubate the cells for 24 hr at 37°C in 5% CO2 incubator. 

8. Do not use the cells immediately after thawing as it contains Dimethyl Sulfoxide 

(DMSO) and some dead cells. Passage them at least once before seeding the cells. 

C.2 Feeding Cells 

1. Remove 3 mL media from 24 cm2 flask into a waste beaker. 

2. Add 3 mL pre-warmed cell culture media to cells. 

3. Label flask with date of feeding and place the flask back into the incubator. 
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APPENDIX D  
 

FIXING CELLS 

Protocol for fixation is explained in following steps: 

1. Remove complete media from cell culture. 

2. Wash the cells with pre-warmed Locke’s solution. 

3. Add the fixing solution (DiffQuik from Siemens) to cover whole surface of well 

or dish and leave it for 10 minutes. 

4. Remove the fixing solution and add Phosphate Buffer Saline (PBS) to cover 

whole surface. 

5. For storage, label the plate or dish, seal with parafilm and keep it at 2-8°C (in 

refrigerator). 
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APPENDIX E  
 

DAPI STAINING PROTOCOL 

1. A 14.27 millimolar concentration of DAPI in DI water was diluted 1 to 1000 in 1x PBS.   

2. Once DAPI has been added place dish in 37ºC incubator for 10 minutes (depending on 

the health of the cells you may need a longer time to load do to the fact that healthy 

cells take longer to load DAPI than damaged or dead cells). 
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APPENDIX F  

 

MTT ASSAY PROTOCOL 

400 uL of MTT solution is added into each well of a 24 well plate. Considering 

this, 9.6 mL of MTT would be needed to treat an entire plate. Usually 11 mL of solution 

is prepared to have a buffer volume. 

Procedure for a 24 well plate: 

1. Weigh 13.75 mg of MTT powder and add it to 11 mL of prewarmed DMEM 

without phenol red (or sterile Locke’s solution). 

2. Media is aspirated from the wells carefully. Do not wash. 

3. Add 400 uL of MTT solution carefully to each well from the side. 

4. Place the 24 well plate in the incubator for 60 minutes to allow the cells to react 

with MTT solution. 

5. The viable cells react, and purple crystals are formed in the wells. 

6. After incubation, aspirate the MTT solution carefully without lifting the crystals 

and add 300 uL of 91% isopropanol to each well. 

7. Allow the crystals to be dissolved into the isopropanol, gently shake the well 

plate. Don’t delay after adding the isopropanol as it will evaporate. 

8. Transfer 300 uL of isopropanol with dissolved crystals into 96 well plate. 

9. Measure the plate using a spectrophotometer at a wavelength of 570 nm. 
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APPENDIX G  
 

GFAP ANTIBODY (AB) STAINING 

1. Fixation of Cells:  

• Remove complete media from cell culture. 

• Wash twice the cells with pre-warmed Locke’s solution. 

• Add ice-cold methanol to cover whole surface of well or dish and keep it for 5 

minutes. 

• Remove methanol and add 1X PBS to cover whole surface. 

• For storage seal the plate or dish with paraffin and keep it at 2-8 ºC (in refrigerator). 

2. Permeabilization of cells: Remove PBS from pre-fixed cells and 0.2 % Triton X 100 

(in 1X PBS) to cover whole surface and keep it at room temperature for 15 minutes. 

3. Blocking: Remove Triton X 100 and add 2% Goat Serum (in 1X PBS) to cover whole 

surface. Seal the plate or dish with paraffin and keep it at 2-8 ºC (in refrigerator) for 4-

5 hrs or overnight. 

4. Primary Ab: Remove goat serum and add 1° Ab (Anti-GFAP produced in rabbit in 

1:500 1X PBS) to cover the whole surface. Seal the plate or dish with paraffin and keep 

it at 2-8 ºC (in refrigerator) for 24 hrs or overnight. 

5. Washing: Remove 1° Ab and wash twice with 1X PBS.
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6. Secondary Ab: Add 2° Ab (1:500 Goat Anti- Rabbit Ig Ab in 2% Goat Serum which is 

in 1X PBS) to cover the whole surface. Seal the plate or dish with paraffin and cover 

with aluminum foil and keep it at room temperature for 45-60 minutes. 

7. Washing: Remove 2° Ab and wash twice with 0.2 % Triton X 100 (in 1X PBS). Lastly 

add 1X PBS to cover whole surface. 

8. Florescence Microscopy: Observe staining using fluorescent microscope. 

9. Storage: Seal the plate or dish with paraffin and cover with aluminum foil and keep it 

at 2-8 ºC (in refrigerator) for storage for weeks. 
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APPENDIX H  
 

Β-GALACTOSIDASE STAINING 

H.1 Reagents Required for Staining 

• 10X PBS  

 70.2 mM Na2HPO4, 14.7 mM KH2PO4, 1.37 M NaCl, and 26.8 mM KCl 

• 10X Fixation Buffer 

 20% formaldehyde and 2% glutaraldehyde in 10X PBS 

• Reagent A - 200 mM MgCl2 

• Reagent B - 400 mM potassium ferricyanide 

• Reagent C - 400 mM potassium ferrocyanide 

• X-Gal - (5-Bromo-4-chloro-3-indolyl-B-D-galactopyranoside) 

• Dimethylformamide (DMF) 

H.2 Preparation Instructions 

• Dilute 10X PBS 10-fold with sterile water to prepare 1X PBS. 

• Dilute 10X Fixation Buffer 10-fold with sterile water to prepare 1X Fixation 

Solution.

• Prepare a 20 mg/mL solution of X-Gal in DMF in a polypropylene tube or a glass 

vial. The solution can be stored in the dark at -20°C for 1 month. 

H.3 Procedure for 48-well Cell Culture Plate 

1. Aspirate the growth medium from the cells. 
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2. Wash cells twice with 300 uL of 1X PBS. Remove the wash solution entirely with 

aspiration. 

3. Add 300 uL of 1X Fixation Solution and incubate 10 minutes at room 

temperature. 

4. During the fixation process, prepare the Staining Solution in a polypropylene 

tube. 

Staining Solution 

Component     Amount  

Reagent A     10 uL 

Reagent B     10 uL 

Reagent C     10 uL 

X-Gal solution (20 mg/mL)   50 uL 

1X PBS     920 uL 

Total volume     1 mL (enough for 3 wells) 

5. Rinse the cells twice with 300 uL of 1X PBS. 

6. Add 300 uL of Staining Solution to the plate. Ensure even coverage of the plate. 

7. Incubate at 37°C for 0.5-2 hr or longer, until the cells stain blue. In the event a 

longer staining period is needed, seal the plate with parafilm to prevent it from 

drying out. The exact incubation time must be optimized. 

8. Observe the cells under the microscope. Count the cells and calculate the percent 

of cells. 

9. For long-term storage of stained plate, remove the Staining Solution, overlay cells 

with 300 uL 1X PBS and store at 4°C. 
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APPENDIX I  

 

RESAZURIN ASSAY PROTOCOL 

Spheroid was moved from original plate to a 96 well-plate in 150 μl media. Each 

well with spheroid will be added 50 μl of resazurin solution. For an experiment with 10 

spheroids, follow these steps. 

I.1 Prepare Resazurin Solution 

1. Prepare the resazurin solution: 

• Weigh 0.4mg of resazurin sodium salt and put in a clean 15ml tube. 

• Add 2ml of sterile PBS 1x to get a concentration of 0.2mg/ml resazurin 

solution. 

2. Procedure for adding resazurin to the cells: 

• Add 50 μl of resazurin solution to each well and mix using pipette. 

• Incubate for at least 4 hours but less than 8 hours in an incubator with 5% 

CO2 and at 37°C.  

3. Procedure for viability reading: 

4. Cover the plate with tin foil and bring it to a fluorescence reader (Gen5 Biotek 

Fluorescence Plate Reader).
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I.2 Measure Viability Using BioTek FLx800 Plate Reader 

1. Turn on the plate reader. Power button located on back bottom right side of the 

device. 

2. Check computer connection/communication with device. 

3. Turn on laptop. 

4. Double click on application icon Gen5 1.08 located on the desktop 

5. “Create a New Item”→ “Protocol” 

a. Double click on “Procedure” on left menu. 

i. “Plate type”→ “96 Well Plate” 

ii. Under the “Add Step” menu on left choose: “Read” 

1. “Detection Method”→ “Fluorescence” 

2. “Filter Sets” → “Excite” → “485/20” 

➔ “ Emission” → “528/20” (These numbers depend 

on the type of fluorescent molecules you are using. 

Shown for Green.) 

➔ “Optics Position” → “Top” or “Bottom” 

➔ “Sensitivity” → 35 or 40 (Higher # = Higher sens) 

➔ Click on “Full Plate” located on upper right of 

panel 

Uncheck “Use all Wells” → Highlight wells you want to read → Click “Ok” on 

this screen 

➔ Click “Ok” on entire panel 
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Go to File → Save As → Local Drive → Choose appropriate file. Be sure to name the 

file in a useful manner). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

   131 

 

APPENDIX J  

 

IMAGE-PRO PLUS VERSION 7.0 

1. Insert the dongle (special security plug) that comes with Image-Pro Plus to unlock the 

program. 

2. Open Image-Pro Plus 7.0. A dialog box ‘Macro Browser’ appears. Click Done. 

3. Go to File → Open → Select the image. 

4. Go to Measure → Count/Size → Choose ‘Manual’ → Click ‘Select Colors’ → A 

dialog box appears. Click ‘Color Cube Based’ → Select Class ‘1’ → Under Options, 

Select Sensitivity ‘4’ → Pick ‘color picker tool’. Then click on the indigo blue color 

staining (Start selecting the color from lightest to darkest) → Under Preview, select 

‘Current Class’ → Change to ‘Class Color on Black’ from ‘Class Color on Transparent’ 

→ Select ‘Apply Mask’ → Click ‘OK’. 

5. Now choose ‘Automatic Bright Objects’→ Click ‘Count’. The white area gets selected. 

6. Go to ‘Measure’ → Click ‘Select Measurements’ → Choose ‘Area’ → Click 

‘Measure’. 

7. Go to ‘View’ → Click ‘Measurement Data’ → Choose ‘Sort Down’. 

8. Go to ‘File’ → Click ‘Export Data’. This will copy the data into an excel spreadsheet. 
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Figure J.1: An example of image analysis to calculate area and length of the CuHARS in 

2D cell culture. 

 

Figure J.2: An example of image analysis to calculate area and length of the CuHARS in 

3D cell culture. 
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